SYSTEMS TOOLS FOR COMPLEX HEALTH SYSTEMS:
A GUIDE TO CREATING CAUSAL LOOP DIAGRAMS

FACILITATOR MANUAL
Course materials developed by:

Helen de Pinho MBBCh, MBA, FCPH
Anna M. Larsen BS, MPH

Averting Maternal Death and Disability Program
Heilbrunn Department of Population and Family Health
Mailman School of Public Health
Columbia University
New York City

February 2015

This work was coordinated by the Alliance for Health Policy and Systems Research, the World Health Organization, with the aid of a grant from the International Development Research Centre, Ottawa, Canada.
# TABLE OF CONTENTS

## SECTION ONE: ABOUT THE COURSE
- INTRODUCTION ........................................................................................................... 5
- OVERALL COURSE AIM .............................................................................................. 5
- TARGET AUDIENCE ................................................................................................ 5
- COURSE OVERVIEW .................................................................................................. 6
- PEDAGOGICAL TECHNIQUE ..................................................................................... 7
- MATERIALS REQUIRED ............................................................................................. 7
- FACILITATOR EXPERIENCE ..................................................................................... 7
- TIME FRAMES FOR RUNNING THE COURSE .......................................................... 8
- COURSE PACK ........................................................................................................ 9

## SECTION TWO: SESSION DESCRIPTIONS
- SESSION 1: INTRODUCTION TO SYSTEMS THINKING ........................................... 11
- SESSION 2: DEVELOPING A RICH PICTURE .......................................................... 24
- SESSION 3: CREATING INTERRELATIONSHIP DIGRAPHS .................................... 34
- SESSION 4: SURFACING CAUSAL LOOP DIAGRAMS ............................................. 41
- SESSION 5: APPLYING SYSTEM THINKING TOOLS .............................................. 57

## SECTION THREE COURSE HANDOUTS
- HANDOUT 2.1 SORTING LAUNDRY WORKSHEET .................................................. 63
- HANDOUT 2.2 PARTICIPANT - CASE STUDY SUMMARY ........................................ 64
- HANDOUT 3.1 INTERRELATIONSHIP DIGRAPH TEMPLATE .................................... 65
- HANDOUT 3.2 IRD DRIVERS AND OUTCOMES DETERMINATION ....................... 66
- HANDOUT 4.1 CAUSAL LOOP DIAGRAM TEMPLATE ............................................. 67
- HANDOUT 4.2 CLD FEEDBACK LOOP TEMPLATE .................................................. 68
- SESSION 5: APPLYING SYSTEMS THINKING TOOLS ........................................... 69
- HANDOUT 5.1 PARTICIPANT - CASE BRIEF. ......................................................... 69
- FACILITATOR NOTE 5.1 – UNDERSTANDING THE SYSTEM DYNAMICS ............ 74
- WORKSHEET: DOWNLOADING AND INSTALLING VENSIM ............................. 80
- GUIDANCE NOTE: HOW TO USE VENSIM TO CREATE CLDS ............................ 82
SECTION ONE: ABOUT THE COURSE

INTRODUCTION........................................................................................................................................5
OVERALL COURSE AIM..................................................................................................................................5
TARGET AUDIENCE.....................................................................................................................................5
COURSE OVERVIEW ....................................................................................................................................6
PEDAGOGICAL TECHNIQUE....................................................................................................................7
MATERIALS REQUIRED............................................................................................................................7
FACILITATOR EXPERIENCE......................................................................................................................7
TIME FRAMES FOR RUNNING THE COURSE...........................................................................................8
COURSE PACK............................................................................................................................................9
INTRODUCTION

“Health systems strengthening” and “scaling up” have become the buzz words throughout the donor and policy world with little attention to a systematic understanding of how best these can be achieved. Policy documents abound describing “what” has to be delivered, but there is limited rigorous evidence around issues of implementation – the “how” of how to deliver evidence based practices at scale, in contexts that are dynamic, political, resistant to change, and complex.

Failure to embrace the complexity of health systems, and failure to ensure that future public health practitioners are armed with systems thinking skills that will enable them to understand, research and intervene in the complex systems appropriately, will condemn us to a vicious cycle of more of the same quick wins and band aid approaches used to manage wicked public health problems.

Increasingly causal loop diagrams (CLDs) are being used to understand and explore complex systems problems. However, there is seldom any discussion of the approach taken to actually develop the CLDs.

This course is structured to lead participants through the process of developing a CLD in a manner that is inductive and that challenges existing mental models and assumptions they have about the complex system under investigation.

A case study will be used as the basis for teaching students an approach to the development and use of causal loop diagrams, and in the process will incorporate a number of other systems thinking tools including: rich pictures (as defined in soft systems methods), boundary determinations, behaviour-over-time graphs, and interrelationship diagraphs.

OVERALL COURSE AIM

This course aims to build skills in developing causal loop diagrams, and utilizing these CLDs to understand the complex adaptive characteristics of the system under investigation and to identify key leverage points.

TARGET AUDIENCE

The course has been developed for public health students and public health practitioners, including policy makers, people engaged in programme implementation and programme evaluation, as well as researchers. The materials contained within the course pack are aimed at providing facilitators with sufficient information, tools, examples, and activities to lead participants through the sessions.
The “Systems Tools for Complex Health Systems” course consists of five sessions. The first session provides a background to systems thinking and illustrates how systems thinking can contribute to overall health system strengthening. The module explores key concepts of systems thinking and complex adaptive systems, and provides a rationale for using an array of systems thinking tools to better understand and intervene in complex health systems.

Over the course of sessions two, three and four, participants are introduced to an array of systems thinking tools, each building upon the other towards the development of causal loop diagrams. Session two begins by examining how our mental models affect how we make sense of the world, and introduces rich pictures and behaviour over time graphs as tools to challenge these mental models. This allows participants to synthesize the richness of elements and dynamics in the health system under consideration.

Session three builds upon the rich picture as participants extract key variables from their rich pictures and explore all possible relationships amongst these variables through the use of interrelationship digraphs. Through this process key drivers and outcomes of the situation are identified. Using the interrelationship digraph, participants then surface a seed model for their causal loop diagram, and in session four, they are guided through a process of building up a causal loop diagram for the system being considered. By identifying the feedback loops in the CLD, participants explore the dynamics driving the health system. Finally in session five, this understanding is applied to identify potential leverage points for interventions in the system.

Throughout the course, examples are provided to illustrate application of these tools in the field. The course also draws on a case study developed from the published work by Rwashana and colleagues, who used systems thinking in health to understand the supply and demand dynamics of neonatal mortality in Uganda⁠.

---

PEDAGOGICAL TECHNIQUE

Adult learning approaches that draw on the participants’ existing knowledge to inform their learning forms the basis of the pedagogical approach used in developing this course. Sessions are structured to maximize participant engagement through in-class discussions, small group activities, and peer assessments, and require participants to think through issues for themselves before they receive new information. Learning is more effective as participants are able to link new ideas and concepts with existing experience and knowledge.

In advance of the sessions, participants are required to do preparatory work which varies by each particular session.

MATERIALS REQUIRED

The course is designed to require minimal supplies. Ideally, the facilitators will make use of the PowerPoint slides provided. For small group work, the facilitators should procure:

- Marker pens
- Flipchart paper
- Post-It sticky notes
- Printed Handouts

VENSIM Software: VENSIM is one of several commercially available programs that facilitate the development of continuous simulation models known as system dynamics models. VENSIM is free for use in education settings. Participants should download and familiarize themselves with VENSIM software prior to beginning the course. VENSIM installation instructions (VENSIM installation) and a guidance note (Using VENSIM to create Causal Loop Diagrams) are included in the course pack.

FACILITATOR EXPERIENCE

In developing this course it is assumed that the facilitators are familiar with health systems, and health systems strengthening. They should also have experience in carrying out group work and/or training workshops.

Ideally, facilitators will initially work through all the sessions, and be familiar with VENSIM prior to leading the course. While it is not necessary to have in-depth knowledge of the full functionality of VENSIM, facilitators should at least become familiar with the functions necessary to draw CLDs using VENSIM. To assist with this process, a step-by-step guide to using VENSIM is provided as part of the course pack – for use by facilitators and participants. A note about downloading a free version of VENSIM is also included.
TIME FRAMES FOR RUNNING THE COURSE

Based on experience, the course is best delivered over a period of at least 4 days, allowing participants sufficient time to engage with the course material in class, and to practice using the various systems thinking tools.

It is possible to complete the course as a full one-day workshop, providing that participants have downloaded and familiarized themselves with VENSIM in advance of the workshop. Suggested time tables for both options are presented in the box below.

Full-day workshop (10 hours)

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>8:00 – 8:15am</td>
<td>Overall introduction</td>
</tr>
<tr>
<td>8:15 – 10:00am</td>
<td>Session One: Introduction to systems thinking</td>
</tr>
<tr>
<td>10:00 – 10:30am</td>
<td>Break for refreshments (20 minutes)</td>
</tr>
<tr>
<td>10:30 – 12:00noon</td>
<td>Session Two: Developing a Rich Picture</td>
</tr>
<tr>
<td>12:00 noon – 12: 45pm</td>
<td>Session Three: Creating an interrelationship digraph</td>
</tr>
<tr>
<td></td>
<td>Part one – identification of variables</td>
</tr>
<tr>
<td>12:45pm – 1.45pm</td>
<td>Break for lunch</td>
</tr>
<tr>
<td>1:45pm - 2:30pm</td>
<td>Session Three: Creating an interrelationship digraph</td>
</tr>
<tr>
<td></td>
<td>Part two – complete IRD and surface drivers and outcomes</td>
</tr>
<tr>
<td>2:30pm – 4pm</td>
<td>Session Four: Surfacing a causal loop diagram Part one</td>
</tr>
<tr>
<td>4pm – 4.20pm</td>
<td>Break for refreshments (20 minutes)</td>
</tr>
<tr>
<td>4:20pm – 5.45pm</td>
<td>Session Four: Using CLDs - Feedback loops and leverage points</td>
</tr>
<tr>
<td>5:45pm – 6:00pm</td>
<td>Wrap up and reflection</td>
</tr>
</tbody>
</table>

Four day course – Day One

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>8:00 – 8:15am</td>
<td>Overall introduction</td>
</tr>
<tr>
<td>8:15 – 10:00am</td>
<td>Session One: Introduction to systems thinking</td>
</tr>
<tr>
<td>10:00 – 10:30am</td>
<td>Break for refreshments (20 minutes)</td>
</tr>
<tr>
<td>10:30 – 1:00pm</td>
<td>Session Two: Developing a Rich Picture</td>
</tr>
<tr>
<td>12:45pm – 1.45pm</td>
<td>Break for lunch</td>
</tr>
<tr>
<td>Afternoon/Overnight</td>
<td>Self-study (in groups or individual – depends upon context)</td>
</tr>
<tr>
<td></td>
<td>Participants identify an area of concern prior to attending the course.</td>
</tr>
<tr>
<td></td>
<td>Develop a rich picture for their particular issue.</td>
</tr>
</tbody>
</table>

Four day course - Day Two

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>8:00 – 8:30am</td>
<td>Review participant generated rich pictures</td>
</tr>
<tr>
<td>8:30 – 10:00am</td>
<td>Session Three: Creating an interrelationship digraph</td>
</tr>
<tr>
<td></td>
<td>Part one – identification of variables</td>
</tr>
<tr>
<td>10:00 – 10:30am</td>
<td>Break for refreshments (20 minutes)</td>
</tr>
<tr>
<td>10:30 – 12:45pm</td>
<td>Session Three: Creating an interrelationship digraph</td>
</tr>
<tr>
<td></td>
<td>Part two – complete IRD and surface drivers and outcomes</td>
</tr>
<tr>
<td>12:45pm – 1.45pm</td>
<td>Break for lunch</td>
</tr>
<tr>
<td>Afternoon</td>
<td>Self-study (in groups or individual) – depends upon context)</td>
</tr>
<tr>
<td></td>
<td>Participants develop the IRDs for their area of concern.</td>
</tr>
<tr>
<td></td>
<td>Identify drivers and outcomes</td>
</tr>
<tr>
<td></td>
<td>Surface seed model</td>
</tr>
</tbody>
</table>
## Course Overview

### Four day course - Day Three

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>8:00 – 8:15am</td>
<td>Review IRDs and share seed models</td>
</tr>
<tr>
<td>8:15 – 10:00am</td>
<td>Session four: Introduce CLDs – use existing case study and demonstrate CLD through iterative process.</td>
</tr>
<tr>
<td>10:00 – 10:30am</td>
<td><strong>Break for refreshments (20 minutes)</strong></td>
</tr>
<tr>
<td>10:30 – 12:45pm</td>
<td>Participants work on their own CLDs in class in order to provide support for the process.</td>
</tr>
<tr>
<td>12:45pm – 1:45pm</td>
<td><strong>Break for lunch</strong></td>
</tr>
<tr>
<td>Afternoon</td>
<td>Self study (in groups or individual)— depends upon context</td>
</tr>
<tr>
<td></td>
<td>Participants finalize their CLDs, and begin to examine their models for possible leverage points.</td>
</tr>
</tbody>
</table>

### Four day course - Day Four

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>8:00 – 8:30am</td>
<td>Review CLDs and discuss challenges to the process</td>
</tr>
<tr>
<td>8:30 – 10:00am</td>
<td>Session five: Develop skills in utilizing CLD to understand underlying dynamics, and identify potential leverage points and policy resistance</td>
</tr>
<tr>
<td>10:00 – 10:30am</td>
<td><strong>Break for refreshments (20 minutes)</strong></td>
</tr>
<tr>
<td>10:30 – 12:30pm</td>
<td>Participants reflect on own CLDs and identify strategic approaches to intervening in the system, providing rationale for their action.</td>
</tr>
<tr>
<td>12:30 – 1:00pm</td>
<td>CLDs in class in order to provide support for the process.</td>
</tr>
<tr>
<td>12:45pm – 1:45pm</td>
<td><strong>Lunch</strong></td>
</tr>
<tr>
<td></td>
<td>Final wrap up and reflection.</td>
</tr>
<tr>
<td></td>
<td>Closing comments</td>
</tr>
</tbody>
</table>

It is also possible to deliver any of the first four sessions as a stand-alone session that would highlight a particular systems thinking approach.

## Course Pack

The full course pack consists of the following resources:

- Course facilitators’ guide (this document). This guide includes:
  - Course overview
  - Description of each session detailing the content to be delivered, materials required, handouts, associated activities and the timing for each session
  - List of supplemental resources for each session
  - Instructions to download and install VENSIM
  - Guidance note on how to use VENSIM to draw causal loop diagrams
- PowerPoint Slide sets for all 5 sessions
- Participant guidance notes
- VENSIM files that can be used for some of the session activities
SECTION TWO: SESSION DESCRIPTIONS

SESSION 1: INTRODUCTION TO SYSTEMS THINKING .......................................................... 11
SESSION 2: DEVELOPING A RICH PICTURE ................................................................. 24
SESSION 3: CREATING INTERRELATIONSHIP DIGRAPHS ........................................ 34
SESSION 4: SURFACING CAusal LOOP DIAGRAMS ...................................................... 41
SESSION 5: APPLYING SYSTEM THINKING TOOLS ..................................................... 57
The purpose of this session is to provide a background to systems thinking and how systems thinking can contribute to overall health system strengthening.

**Total session time: 110 - 120 minutes**

Session Objectives:
By the end of the session, participants will be able to:

1. Define systems thinking
2. Explain the rationale for adopting a systems approach to understand complex health systems problems
3. Explain the importance of “systems thinking” to health systems
4. Describe characteristics of complicated vs. complex adaptive systems

---

1. Introduction to goals of the session (5 min)
Facilitator outlines the session (*Refer Session 1 PPT slide # 5*)

Highlight:

- The purpose of this first session is to provide a brief background to systems thinking and how systems thinking can contribute to overall health system strengthening.
- Review session objectives:
  - Explain the rationale for adopting a systems approach to understand complex health systems problems
  - Define systems thinking
  - Describe characteristics of complicated vs. complex adaptive systems
  - Characterize the differences and synergies between systems thinking and traditional approaches to problem solving
  - Introduce system thinking tools

**Session outline**

- The complexity of health systems
- Thinking about “systems”
- What is systems thinking?
- How can systems thinking help us address health system challenges?
- Introducing systems thinking tools
SESSION 1: INTRODUCTION TO SYSTEMS THINKING

2. Discussing the complexity of health systems (10 min)

2.1 Group Activity
What is the current reality facing health systems? Facilitator asks participants to **brainstorm** common issues and problems that public health practitioners and policy makers, and other key stakeholders face when interacting with and working in health systems. Participants should include in their discussion a reflection on what might have changed over time. *(Refer Session 1 PPT slide #7)*

Participants are asked to reflect on this individually for 5 minutes and then share thoughts in plenary (can also have participants share their experiences in pairs before feedback in plenary).

Facilitator captures insights on board/flip charts.

**Debrief:**
Facilitator to highlight issues of increasing complexity including:
- Managing multiple relationships across wide variety of stakeholders
- Need for increased integration of services, programs
- Increasingly complex flows of funding, communication channels

*Note: This list can be adapted according to the setting*

**Ask participants** where most time is spent (a) managing and (b) understanding the reality of health systems *(Refer Session 1 PPT slides #9, 10)*
- Highlight tendency to respond to events and symptoms rather than identifying patterns
- While research work focuses on looking at patterns and trends, often fails to understand the underpinning structure and dynamics across the system necessary to adequate manage this complex reality
- Instead of fire-fighting, need to be better at identifying and anticipating trends
- Think about how to redesign the system for more fundamental change
3. Thinking about systems (40 min)

3.1 Interactive lecture (Refer Session 1 PPT slides# 12-21)

Highlight:

- A system is not merely a set of components – it is made up of components that are interconnected and interacting over time to give rise to a new function/ emergent behaviour that is of interest.
- Classify systems according to degree of certainty about the link between cause and effect, and the degree of agreement as to the best course of action in a situation. *(Refer Session 1 slide# 17)*
  - Simple systems are characterized when cause and effect linkages are easily determined and repeatedly reliable – when past experience can easily predict future outcomes with a good degree of certainty and when there is high level of agreement within the group or organization about how best to intervene in a given situation.
  - Issues that exist at the other end of the certainty continuum are often new or unique where cause and effect are not clear, and past experience is not a reliable method of determining outcomes, and there is no agreement as to how best to intervene. These are random or chaotic systems
  - Complex systems are in between. It is possible to determine the pattern of linkages amongst the variables, and this in turn would provide some indication of where best to intervene or leverage the system to maximize desired outcomes

- Can distinguish between simple, complicated and complex systems. How we understand and intervene in a system is determined by whether the system is simple, complicated or complex.
Example of general types of systems:

- **Simple (puzzle)** - a car key is simple
  - It does not take long to understand how a car key works. Can figure out mechanisms of action quickly, and because it is predictable we will know how to start the car the next time the key is used. There is high degree of certainty and high agreement as to how to use a key.

- **Complicated (problem)** - a car is complicated.
  - May take some time to about all the details of a car – how each mechanical and electrical piece works together but this task is doable. Can learn with good predictability how to control a car, take it apart, reassemble it and drive it just as before taking it apart. There is a lot of detail but the outcome is certain.

- **Complex (mess)** - car traffic is complex.
  - No matter how many times I drive to work, things are different every time. There is no way to fully understand what happens around me on the road, how other drivers operate their vehicles and how people in the streets interact. I can make guesses, and I can gain experience in predicting outcomes, but I will never know for sure. Each time I need to adapt my driving to accommodate the changes around me. And as I adapt my driving, so I impact on other drivers around me as well as the pedestrians, not to mention the cyclists. We are all in this web together – moving forward in time.

Discuss the following examples of simple (following a recipe), complicated (sending a rocket to moon) and complex (raising a child) systems.

When comparing different types of systems consider issues of:

- **Predictability of results**
- **Replicability of efforts to give rise to similar results**
- **Importance of relationships**
- **Applicability of formulae**
Ask participants to work in pairs and identify examples of complicated systems and complex problems:

- Discuss examples in plenary, teasing out features that make an issue complicated versus complex.
- Understand the implications of these features for strategies to intervene in the system. Need to draw on an array of approaches depending upon nature of the system in a given context.
- Note that although policy making has aspects which are simple, and aspects which are complicated, most challenging issues are complex but are assumed to be simple and hence managed as merely simple or complicated issues – this may be reason for many stagnating or failed interventions.

Ask participants to identify whether the systems listed are simple, complicated, or complex. Refer Session1 PPT slide# 22 (can add more context specific examples)

Debrief:

- Note that some elements of a problem may be complicated – e.g. working out supply chain logistics, but running the system where people are interacting and making discretionary decisions makes the system complex.
- Introduce idea of complex adaptive systems.
SESSION 1: INTRODUCTION TO SYSTEMS THINKING

- Complex adaptive systems are characterized by the following:
  - Difficult to identify linear path of causality
  - Feedback loops
  - Change over time due to interrelated web of factors acting together
  - Context specific
- These interactions give rise to emergent properties.
- New policies and actions (of different stakeholders) often generate counterintuitive and unpredictable effects, sometimes long after policies have been implemented = policy resistance.
- Important to consider that health system problems are generally treated as if they were simply complicated that can be broken down into parts to be solved rather than understood as complex adaptive systems requiring an understanding of the whole system and the web of interacting dynamics amongst the components of the system.

4. Defining systems thinking (10min)

4.1 Interactive lecture (Refer Session 1 PPT slides#26-28)
Ask participants to review the three definitions of systems thinking provided and work on their own to tease out important areas of emphasis. (Refer Session 1 PPT slides # 26-28)

Debrief in plenary
Highlight:

What is systems thinking?

“Systems thinking is a discipline for seeing wholes, recognizing patterns and interrelationships, and learning how to structure those interrelationships in more effective, efficient ways.”

— Senge & Lannon-Kim

What is a Complex Adaptive System?

“A complex adaptive system is a collection of individual actors with freedom to act in ways that are often not predictable, and whose actions are interconnected, so that one agent’s actions changes the context for other agents.”

Health systems are complex systems

- Observation of health systems—including findings from failed interventions—tells us that a health system is a complex adaptive system

But

- Methods for addressing health system problems are designed as though the health system is merely complicated

What is systems thinking?

“T is a way of thinking in approaching problems and in designing solutions that appreciate the very nature of complex (adaptive) systems as:
  - dynamic, constantly changing,
  - governed by history and by feedback,
  - where the role and influence of stakeholders and context is critical, and
  - where new policies and actions of different stakeholders often generate counterintuitive and unpredictable effects, sometimes long after policies have been implemented = policy resistance.”
SESSION 1: INTRODUCTION TO SYSTEMS THINKING

- Systems thinking is important as an approach to understand and analyse complex systems – looking at the whole, the interrelationships and the underlying patterns
- The short and long term consequences of the same action may be different
- The consequence of an action in one part of the system could be completely different from its consequences on another part of the system, well-intentioned actions may lead to nonobvious counter-intuitive results:
  - Multiple leverage/entry points
  - Trade-offs and choices
  - Identifies stakeholders/partners
  - Potential policy resistance

What is systems thinking?

It is a way of thinking in approaching problems and designing solutions that ...

- allows the identification of solutions that simultaneously address different problem areas and leverage improvement throughout the system.

5. Using systems thinking to address health system challenges (20min)

5.1 Interactive lecture (Refer Session 1 PPT slides #32 – 49)

Note: This section is long and the facilitator might want to begin by asking participants how systems thinking can support health systems strengthening.

Useful to reflect back on examples participants provided at the beginning of the session highlighting the complexity of health systems and the challenges of understanding and intervening in the current system.
Given that health systems are complex adaptive systems, systems thinking enables a shift in how we see, think, and act in relation to the health system.

See differently *(Refer Session 1 PPT slides #34 – 38)*

Think differently *(Refer Session 1 PPT slides #39 – 43)*

*We cannot solve our problems with the same thinking we used when we created them.*

-Albert Einstein
Note:

- Rather than first breaking down a system into smaller sub-systems in order to analyse the system, a systems thinking approaches supports an initial understanding of the whole system and the dynamics at work in that system (synthesis), before moving to analyse particular aspects of the system.
- This systems thinking approach prevents a type three error – coming up with a solution to a problem that is not fully understood or articulated.

**Act differently (Refer Session 1 PPT Slides #44 – 49)**

**Think differently**

*Without Systems Thinking…*

We risk doing the wrong things with greater and greater efficiency rather than establishing what is the right thing to be doing.

“*It is better to do the right thing imperfectly than to keep doing the wrong thing better and better.*

Russell Ackoff (1995)

*Without Systems Thinking…*

We are at risk of committing a Type III Error - the right answer for the wrong question (G. Schwartz 1960)

*In other words we have the perfect solution for a problem that has not been adequately understood.*

**Act differently:**

*“We need new ways of thinking and of working in order to accommodate the complexity of the challenges in and urgent need for health system innovation and change.”*

( Herbert and Best 2011)

*“Accept that systems thinking is about dealing with the inevitable lack of comprehensiveness, and is not the means to achieve comprehensiveness”*

**Act differently:**

- Systems thinking tools enable us to:
  - Challenge assumptions
  - Make sense of the complexity
  - Model a situation over time
  - Identify appropriate leverage points for intervention
  - Mitigate policy resistance
  - Enable collaboration and sharing

**Act differently:**

Systems thinking tools enable three functions:

- **Synthesis:** putting together, assessing the system as a whole in its environment/context e.g. Rich Picture, Interrelationships
- **Analysis:** (combined with synthesis) understanding the detail and how the components fit together within a context e.g. Systems Map, Causal Loop Diagrams
- **Inquiry:** developing robust interventions through a systematic investigation e.g. Systems Dynamic Modeling, Scenario Planning
SESSION 1: INTRODUCTION TO SYSTEMS THINKING

6. Introduction to systems thinking tools (15min)
Refer to Session 1 PPT slides #51 - 58

Note: The next three sessions of the course will explore a number of systems thinking tools, their application and how they build upon each other to enable synthesis, analysis and inquiry.

The course will focus on three specific tools - rich pictures, interrelationship digraphs, and causal loop diagrams. In the process of constructing a causal loop diagram participants will:

- Identify an area of concern.
- Develop a rich picture drawing on existing published and unpublished data, relevant research, and stakeholder experience.
- Surface key variables.
- Explore how these elements relate to one another.
- Challenge existing assumptions and mental models.
- Identify major drivers and outcomes through the interrelationship digraph.
- Use the IRD to surface a seed model that is relevant to the modeller’s specific frame of reference.
- Build up a causal loop diagram through an iterative process using the IRD as a base.
- Identify the nature of the relationship between all the variables in the CLD.
- Surface feedback loops and identify the types of feedback loops in the CLD.
- Explore the dynamics of the system under consideration.
- Think about the possible leverage points and the specific level of the levers available to affect change in the system.
- Identify appropriate interventions that will maximize impact in the given context as well as mitigate potential policy resistance; and finally revise and review the CLD following each intervention.
SESSION 1: INTRODUCTION TO SYSTEMS THINKING

What we will do:
Create and use our own causal loop diagrams

To end up here...

We need to first:

- Define the boundaries of our system – seek to understand the big picture
- Identify the elements / variables in our system
- Understand how these variables might change over time
- Surface and test our assumptions (consider how our mental models affect our understanding of the current reality)

To do all of the above we develop a RICH PICTURE

Then we will:

- Explore how these elements / variables relate to one another
- Resist coming to a quick conclusion and once again surface and test our assumptions
- Identify the major drivers and outcomes in our system

To do this we develop an INTERRELATIONSHIP DIGRAPHS

Interrelationship Digraph
7. Wrap up and questions (10 min)

Wrap up highlighting links between health systems, complex adaptive systems and the need for a systems thinking approach.

Assign participants “homework” for Session 2: read Handout 2.2 Case study summary.
SESSION 1 ADDITIONAL RESOURCES

SESSION 2: DEVELOPING A RICH PICTURE

This session aims to orientate students to the concept of mental models and teach them how to diagram systems in the form of a rich picture.

**Total session time: 100 minutes**

**Session Objectives:**
By the end of the session, participants will be able to:
1. Why use systems thinking tools – mental models
2. What is a rich picture?
3. How do we develop a rich picture?
4. How do we define the boundaries of our rich picture?
5. Using rich pictures in the field

**Session resources required:**
1. PowerPoint slides
2. Handout 2.1 Laundry activity
3. Handout 2.2 Case Study

1. **Introduction to goals of the session (5 min)**
   Facilitator outlines the session (*Refer Session 2 PPT slide # 3*)
   Highlight:
   - Review key concepts from session one with focus on understanding health systems as complex adaptive systems.
   - Discuss relevance of systems thinking tools to understanding and intervening in health systems.
   - Review specific session objectives.

**Session outline**
- Why use systems thinking tools – mental models
- What is a rich picture?
- How do we develop a rich picture?
- How do we define the boundaries of our rich picture?
- Using rich pictures in the field
2. Why use system thinking tools – mental models (10 min)

2.1 Present story of six blind men who are asked to describe what they are can feel and experience when faced with different parts of an elephant.

Highlight:
• Need to be able to see the whole in order to make sense of the animal.
• Each man will describe the part they can feel with reference to something that is already known to them from past experience.

2.2 Group exercise – sorting laundry (optional) (Refer Session Two PPT Slide #7)

Participants working on their own.
Handout 2.1 Laundry list (Note: list can be modified according to context)
Instructions:
• Working on their own participants are asked to sort a list of dirty laundry into separate piles ready to be washed.
• They can have as many piles as they want.
Debrief:
• Facilitator asks by show of hands how many piles of laundry.
• Ask participants:
  o What criteria they used to sort laundry?
    ▪ Value of the clothes
    ▪ Time available
    ▪ Cost
    ▪ Nature of the fabric
  o How did they learn to sort laundry?
• Highlight that there is no right/wrong way - will depend on expectations, bias, experience.
• These represent our mental models, and are present for almost all situations that we face in our lives. They are our ways of making sense of the world.
2.3 Interactive lecture: Mental Models (Refer Session 2 PPT slides #8-11)

- Our mental models help shape our behaviour and define our approach to solving problems and carrying out tasks.
- Mental Models are shaped by our personal experiences, expectations, biases, knowledge.
- Normally there is not a problem with our mental models because they appear to work in most cases. As a consequence we develop routines and skills that are based on our mental models e.g. driving early to work to avoid traffic or putting on a jacket before going outside, etc.
- These routines seem very simple and obvious and not necessary connected to mental modelling, but we have grown unconscious of our routines since the models we have developed about them are working just fine. We base all our decisions on our mental models and since we often become so dependent on our routines and skills we have difficulties to detour from our route in order to take in new understanding.
- This can be a problem in complex situations where we are not able to look past our mental models to better understand the problem, see new relationships and explore alternative solutions.
- We use systems tools like rich pictures and interrelationship digraphs to break through these mental models.

We need to take time to examine our mental models and make them explicit, especially when working with others, otherwise we create misunderstandings and fail to fully understand the underlying structures and systems that give rise to the behaviour in the system in which we are seeking to intervene.
• Highlight the importance of using tools that challenge our mental models and assumptions and force us to make our mental models explicit.
• This is particularly important when working in collaboration with others, who hold their own mental models.
• We should not assume that we share a common understanding of a particular problem, or if there even is a problem.

3. Defining a rich picture (15 min)
(Refer Session 2 PPT slides #13,14)
Highlight:
• A rich picture is simply a drawing of the way you see a given situation at a particular moment in time.
• The quality of the art is not important.
• What matters is that you represent all of the elements, relationships, emotions, and interactions relevant to the issue at hand.
• Try to use symbols and images instead of words, as this will facilitate your exploration of thoughts you have not already articulated.
• Rich pictures are often used in the synthesis phase as a mechanism to gather and capture information about complex situations as you begin trying to understand the complex issue.
• Rich pictures are ideally built through an iterative process of engagement and reflection with a group of key stakeholders.
• If you are working in a group, it can be helpful for each individual to draw her or his own rich picture and then have the group come together to discuss the different rich pictures.
• Sharing rich pictures with the group can help air individuals’ differing perceptions and/or assumptions about the same issue.
• This in turn can pave the way for individuals to shed their mental models and work together to develop a more complex understanding of a situation.
4. Developing a rich picture (15 min)

Highlight:
Include the following in a rich picture:

- Issues and concerns—what are the motivations and perceptions of each of the key stakeholders in this situation?
- Structure—this refers to things like organizational structure, geographic location, physical layout and all the people who are affected by the situation.
- Process—this refers to flows or transformations that occur within the structures such as flows of goods, information, resources. Useful to include “behaviour over time” graphs as tool to illustrate trends.

The behaviour-over-time graph is a useful tool to capture patterns of change over time.

- It is a basic line graph showing the trend, or pattern of change, of a variable over time, and when the pattern is not as expected, forces us to think about how and why these patterns occur.
- The X axis is always labelled in units of time or can reflect change in time with defined beginning and ending points.
- Make sure that there is a clear logic to the time scale, why does it start and end where it does?
- Examination of when and where a particular pattern of behaviour starts, ends, or changes direction is also important.
- The Y axis clearly identifies the variable being graphed and must be labelled with that variable’s name.
- The variable can be “concrete” with easily measurable quantities, or “abstract” (e.g. stress, transparency), and should have a defined scale.
- Scales can be numeric (e.g., 2 to 1000 patients or “on a scale of 0 to 100...”) or descriptive (e.g., low vs. high).
When creating Rich Pictures it is important to avoid certain traps. Facilitator should refer to the “Participant Guidelines: Steps for Creating a Causal Loop Diagram” document for further details regarding the traps to be avoided.

5. Determining system boundaries
Highlight:
- Remind participants that rich pictures support a process of synthesis.
- The purpose of the rich picture is to create a model that is sufficiently rich to capture key elements, but is not meant to capture every element – it is not a mirror.
- For this reason it is important to be explicit about what and who is included and excluded from the system.
- To determine the boundaries of the system consider the following:
  - What is the main issue of focus?
  - What is an appropriate time horizon? (Do not be too narrow).
  - What is the primary level of interest in the system e.g., is it at national level? global? community?
  - Who are the key stakeholders and are their voices captured in the rich picture?
  - What are the implications of excluding specific voices?
  - Be conscious of who is developing the rich picture – what information is being used to inform the picture?

6. Draw a rich picture (45 min)
6.1 Group Work:
Facilitator introduce task. *(Refer Session 2 PPT slide# 22)*
Participants review the case study (Handout 2.2 Case Study )
(Note: facilitator may want to request that participants read case study in advance of session)
Participants work in teams of 4 – 5 people to develop a rich picture (20 min)
- Remind participants to identify the boundaries of the system – who are they in the system?
- Identify behaviour over time graphs that can be included
At end of 20 minutes ask participants to review their rich pictures and discuss the questions in Session 2 PPT slide #23

- Each group then hangs their rich picture on the wall
- Gallery walk to review rich pictures – participants circulate and review other groups’ work
- Facilitator debrief from rich picture
  - Key lessons learnt during process and comparison across rich pictures.
  - Emphasize challenging mental models/assumptions and importance of doing this in a team.
  - Discuss the source of information, what is considered valid information, whose voice is included and who is excluded?
  - Reflect on boundary decisions.
  - Identify principles of complex adaptive systems.
  - Highlight that process of creating a rich picture in a team is often as important (if not more so) than the outcome.

- Optional: Facilitator share pre-prepared rich picture based on the case study – discuss how this rich picture compares with those developed by participants.

---

**Neonatal deaths in Uganda case study group exercise—develop a Rich Picture**

- Review the case study provided
- Draw a “Rich Picture” to explain the situation – stagnation of neonatal deaths
- Use the information provided in the case study, as well as draw upon your own experience and existing literature.
- Be prepared to share your “Rich Picture” with the other groups

---

**Reflecting on the Rich Pictures**

- Briefly describe the situation
- Identify:
  - Relationships and connections
  - Stakeholders
  - Behavior over time
  - Locations
  - Activities
  - Different “stories”
- What makes this a complex system?

---

**Rich Picture base on Uganda neonatal case study**
5. Using rich pictures in the field (10 min)

Ask participants to identify opportunities in their own context where they could use rich pictures – what might be barriers to using rich pictures?

When to use a rich picture?

- Working with diverse groups with different perspectives – often time efficient
- Start thinking about the different factors that are impacting or are part of your “problem situation”
- As first step towards identifying key variables that are drivers, outcomes and leverage points in a situation
- Facilitator does not require extensive content knowledge to facilitate rich picture development

Examples of good Rich Pictures

Note the:
- “Richness”
- Inclusion of many stakeholders
- Use of behavior over time graphs
- Relationships amongst different elements

Example One: Strengthening human resource management information systems

- This Rich Picture was developed by a team looking to improve the availability of human resource for health data in a country.
- The group consisted of participants from ministry of health as well as collaborating donor partners.
- It was only when they began drawing the flow of information from the ground up and from the Ministry of Health down that they realized that the two “routes” were quite separate from each other – accounting for the lack of coordination and poor quality of data. This was then used as the basis of developing a proposal to strengthen the overall system.
Example Two: Addressing high maternal mortality

- This rich picture was developed by a team examining sustained maternal mortality in a poorly performing district in a low – middle income country.
- While it is not the “richest” rich picture, what made it valuable is that it was developed by a team of stakeholders meeting for the first time.
- The team included maternal health programme managers from the district, province and local levels, frontline midwives at rural clinics, hospital managers, emergency response workers, and a pharmacist from central medical supplies.
- The process of drawing resulted in the exposure of numerous mental models and assumptions.

7. Wrap up and questions (5 min)

Highlight:

- Review session learning objectives – focus on importance of making mental models explicit
- Use of rich pictures to capture interactions amongst elements and stakeholders in a system
- Identify system boundaries
- As important step towards developing causal loop diagram
SESSION 2 ADDITIONAL RESOURCES

- Systems Thinking and Practice: Diagramming. The Open University. Source http://systems.open.ac.uk/materials/T552/
SESSION 3: CREATING INTERRELATIONSHIP DIGRAPHS

This session aims to orientate students to interrelationship digraphs and teach them how to use them in the next step toward creating a systems map.

**Total session time: 100 minutes**

**Session Objectives:**
By the end of the session, participants will be able to:
1. Identify and define key variables
2. Develop an interrelationship digraph
3. Determine key drivers and outcomes in the system
4. Apply interrelationship digraphs in the field

**Session resources required:**
1. PowerPoint slides
2. Rich pictures previously developed
3. Handout 3.1 IRD template or use VENSIM file (Session 3 IRD_template.mdl)
4. Handout 3.2 IRD drivers and outcomes or use VENSIM file (Session 3 IRD_Driver_Outcome.mdl).

1. **Introduction to goals of the session and to interrelationship digraphs (15 min)**

Facilitator outlines the session *(Refer Session 3 PPT slide # 3)*

Highlight:
- Review development of rich pictures from previous session
- Emphasize importance of making mental models explicit
- Review specific session objectives
- Use interrelationship digraphs (IRDs) as a system thinking tool to:
  - Synthesize key system dynamics
  - Explore how variables relate to one another in a complex system
  - Force a consideration of all possible interactions amongst the variables thereby preventing coming to a quick conclusion
  - Surface and test assumptions i.e. challenges mental models
  - Identify major drivers and outcomes in a complex system
  - Form the basis from which to identify a seed model and begin to surface a causal loop diagram
- Note that while many model developments move directly to creating CLDs without developing rich pictures or IRDs they are at risk of simply recreating a CLD based their own theory of how the system is functioning, without exploring all possible relationships through the IRD process.
The IRD is a visual tool that:
- Builds on the rich picture
- Helps make use of team knowledge in the absence of hard data;
- Plots the complexity of causal relationships
- Builds team consensus on priorities

The IRD enables identification of:
- Drivers (the fundamental elements of a system that drive the other parts)
- Outcomes (the elements of the plan that can be used to measure success)
- Systems understanding of the causal relationships

2. Developing an IRD – Identification of key system variables (30 min)

2.1 Interactive lecture
Highlight: *(Refer Session 3 PPT slides#6, 7)*
- First step to creating the IRD is to identify between key variables from the rich picture.
- Goal is not to identify every variable related to a given issue, but to capture the factors that, if changed, would have the biggest effects on the outcome of interest.
- Important to agree on the issue or question – which informed your rich picture and variable selection.

- Aim for 10-12 variables, and can consolidate some variables.
- Define key variables to ensure common understanding of construct underpinning the variable.
- Variables should be measurable or observable, and should represent quantities that can change over time. Something like “state of mind” can’t be measured, but “staff motivation” can and typically changes over time.
- Variables should be neutral. “User fees” is better than “high user fees” or “increasing user fees.” “Quality of care” is preferable to “good care” or “bad care”.
• When applicable, choose the positive sense of variable over the negative sense. “Staff motivation” is better than “Staff demotivation”.
• When appropriate, distinguish between perceived and actual states. “Perceptions of quality of care” can differ from “actual quality of care”.

### Definition of a variable
- An element in a situation that may act or be acted upon.
- Its value can vary up or down over time.
- Is not an event.
- Is something you can discuss as “the level of…”
- Neutral
  - Quality of Care vs. Poor quality of care
- Distinguish between perceived and actual states
  - Perceptions of Quality of care vs. Quality of Care
- Include outcome of interest

### 2.2 Group activity [10min] (Refer Session 3 PPT slides # 8-10)
Working in groups of 3-4 - Participants will use the neonatal mortality case study introduced in Session 2 together with the Rich Pictures they developed to identify and define 10 – 12 key variables.
- Groups should write up their variables and associated definitions on the flip chart paper provided.
- After 10 minutes stop the discussion and ask each group to review the lists, including their own and reflect on the following:
  - Are the variables identified – measurable (in theory), clearly defined and neutral?
  - Do they include the outcome of interest?
  - How do the lists differ from one another – what has been left out of the lists and what are the implications of these omissions?

Debrief:
Ask participants to compare their lists, including a list pre-generated by facilitator (Refer Session 3 PPT slide # 10)

Discuss:
- What might be the reason for selecting different variables?
- Highlight that variables selected will be determined by the systems boundaries including primary level of interest.
3. Developing an interrelationship digraph (30 min)

3.1 Interactive Lecture
Highlight:

To begin developing the IRD

- Agree on the issue or question – that informed your rich picture and variable selection.
- Arrange the selected variables in a circle, place labels or “post-its” for every element involved in the issue.
- Pick one of the variables to begin, and think about its relationship with each of the other variables in your circle.
- Move onto the next variable in the circle and consider where there is a relationship between that variable and all others in the circle.
- Continue until you have explored potential relationships amongst all variables.
- Consider the relationships in pairs (you do not have to find a relationship between each pair).
- Use an "influence" arrow to connect related elements.
- The arrows should be drawn from the element that influences to the one influenced.
- If two elements influence each other, the arrow should be drawn to reflect the stronger influence. Arrows can only be drawn IN ONE DIRECTION.
- The relationship should be a direct relationship and not via another variable.
- When you are thinking about how one variable relates to another, be sure to consider short term effects, long term effects, and unintended consequences.
- Try to abandon your mental model and think about associations you might not have initially identified.
- Where possible base your decision on existing evidence, or consensus amongst experts and be aware of your own assumptions.
**3.2 Group work (10 min) (Refer Session 3 PPT slides #14 – 15)**
Participants working in groups of 3 – 4

Facilitator begins the process of comparing variables – pick a starting point and then systematically compare each variable with the rest of the variables in the IRD.

Participants complete the process, using template provided (either in hard copy or VENSIM file).

**Debrief:**
- Present complete prepared IRD (Refer Session 3 PPT slide #17)
- Ask participants:
  - About the assumptions that were surfaced
  - What information informed their decisions
  - How system boundaries impacted their decisions – thinking about short term and long term effects

Remind participants that the IRD is a visual tool that:
- Builds on the rich picture
- Helps make use of team knowledge in the absence of hard data
- Plots the complexity of causal relationships
- Builds team consensus on priorities

---

**3.2 Activity resources:**
- Copies of Handout 3.1 IRD template or use VENSIM file (Session 3 IRD_template.mdl) with partially completed IRD
4. Determining drivers and outcomes (15 minutes)

4.1 Interactive Lecture
(Refer Session 3 PPT slides #21 – 23)
Once you have examined all the possible relationships amongst the variables it is possible to identify the drivers and outcomes in the system.

- For each variable, count the number of arrows coming in and going out:
  - Outcomes: Variables with more arrows coming in than out
  - Key Outcomes or Results: Variables with the most incoming arrows
  - Drivers: Variables with more arrows going out than in
  - Root Causes: Variables with the most outgoing arrows

In VENSIM it is possible to rearrange the variables so that the drivers are at the bottom of the IRD and the outcomes are at the top.

Variables with similar number of arrows coming in and out are often important leverage points when included in the causal loop diagram.

4.2 Group activity:
Participants continue working in their groups of 3 – 4
- Using Handout 3. IRD drivers and outcomes or VENSIM file (IRD Driver_Outcome.mdl) – participants determine the drivers and outcomes for the Neonatal Case study

Debrief:
Ask: how does this inform how we might intervene in the system, and how we might evaluate the system?
5. Wrap up and questions (10 min)

Highlight:

Purpose of Interrelationship Digraphs is to:
- Encourage team members to think in multiple directions rather than linearly.
- Explore the cause and effect relationships among all the issues, including the most controversial.
- Allow key issues to emerge naturally rather than to be forced by a dominant or powerful team member.
- Systematically surface the basic assumptions and reasons for disagreements among team members.
- Allow a team to identify root cause(s) even when credible data does not exist.

Thinking forward to next session, IRD provides basis for identifying a seed model upon which to begin the development of the causal loop diagram.
The purpose of this session is to teach participants about surfacing causal loop diagram and using these CLDs to explore the system dynamics and potential leverage points.

**Total session time: 120 - 135 minutes**

Session Objectives:
By the end of the session, participants will be able to:
- Identify the causal loop diagram (CLD) seed structure
- Build a causal loop diagram
- Attribute the polarity of variable relationships
- Surface feedback loops and identify the type of feedback loops
- Explore range of potential leverage points
- Discuss mechanisms to mitigate policy resistance

1. **Introduction to goals of the session (5 min)**
Facilitator outlines the session (*Refer Session 4 PPT slide # 3*)
Highlight:
- Review interrelationship digraphs.
- Emphasize that the process of transforming an IRD into a CLD is an involved and iterative process.
- For the model developer, the objectives of this exercise are to use the IRD to surface the CLD rather than rely on their own mental models of what they think is happening in a system, and then to explore the dynamic relationships in the system.
- Although there is no such thing as a “final” CLD, the model developer should strive for a CLD that can tell a clear story about a complex reality without being overly complex (and not too simple).
2. Identify the CLD seed structure (20 min)

2.1 Interactive Lecture:
Highlight:

- Every CLD begins with a simple seed structure that includes the output or outcome of interest together with the drivers of that output.
- The questions that arises is which variables to select for the seed structure. For this we need to think back to some of the boundary questions that we posed when developing the rich picture, and then use the IRD to identify those variables.
- The seed structure should reflect the level of interest at which you and your team have the power to influence or investigate. This is not to say that you will not end up adding in more upstream or downstream drivers or larger impact variables or intermediate variables, but for now we are simply looking at the point at which to begin developing the CLD.
- Consider: What is the question or issue that is driving the creation of the CLD?
  - The CLD is not an end in itself, it is developed to address an issue — whether this is through interventions, or identifying what new knowledge and research is required.
  - What is the issue that triggered the rich picture and IRD?
  - How has their thinking changed following that process?
- Ask participants to articulate the issue in more specific terms and write this down. This will be used this to develop the seed model upon which the CLD will be constructed.
- What are the boundaries of their system?
  - What should be included in the CLD?
  - Remind participants that they are not trying to draw the whole system, only those parts impacting on their issue.
  - Be aware of whose voices are excluded and the implications of that decision.
- Think about the level at which they want to intervene?
- Ask participants to consider the following as they surface their CLD:
  - Be aware of who “they are” in the process? Most commonly, the development of a CLD is informed through a collaborative process.
  - Be aware of who is in the room developing the CLD, and at what level of the system the group is situated and able to intervene. Are they at a national policy level, or district, facility, community? NGO or private versus public?
  - Understanding the sphere of influence will help identify a starting point from which to build out the model. This does not mean that participants should not include variables that are above or below their identified reference level.
2.2 Participant Activity

**Working in pairs** – Participants refer to the Neonatal case study used in Sessions 2 and 3 to identify seed structures appropriate for the following reference levels:

- District health manager
- Minister of health
- Pregnant women in a rural area

Participants should use the IRD provided (Handout 4.1) to identify appropriate outcome/output and driver relevant to reference level.

**Debrief:**

- Ask different pairs to share seed structures, and provide their rationale for selection
- Discuss how these seed structures might differ
- Important to emphasize seed structure is simply a starting point for the CLD

Provide an example of seed structure: *(Refer Session 4 PPT slides # 7,8)*

- Selected “level of awareness of maternal and newborn health care” as a driver of “mothers attending ANC, hospital deliveries and PNC”, which in turn drives “safe deliveries” which drives (down) the” risk of neonatal death”.
- While socio-economic status could also be included, if the primary level of interest/reference level is at clinic level, it would be more useful to select a driver at that level, rather than one that is more distal.
3. Build a causal loop diagrams (20 min)

3.1 Interactive Lecture: (Refer Session 4 PPT slides # 10 – 19)

Highlight:

- Examine the IRD and explore the linkages between variables in the seed model and other variables.
- Identify intervening variables that help to explain the situation (as observed, or described through research).
- Explore linkages amongst the other key variables in the system, looking for feedback loops.

- Using a highlighter, trace the loops that are associated with the outcome.
- Some of the smaller loops may be redundant with respect to larger, more encompassing loops. If this is the case, delete arrows that indicate redundant loops.
- May identify cases in which it is possible to delete an arrow indicating a direct relationship where in fact an indirect relationship better illustrates the pathway of effect (For example: If the IRD shows that A → C, but also that A → B → C. If the latter relationship captures the mechanism of effect whereby A drives C, then can delete the arrow directly connecting A and C).
- As participants work through this process they may discover that instead of deleting they need to add arrows. For example, in the IRD only unidirectional arrows were permitted between two variables when in fact the variables are re-enforcing.
Ask participants to identify what intermediate variables can be included to better explain the relationships between “safe deliveries” and “mothers attending services”, and between “resource adequacy” and “mothers attending services”?

- Identify which (if any) links have significant delays relative to the rest of the diagram. It is important to identify these delays as they are often the source of imbalances that accumulate in the system. Depict a delay in the system by using small parallel lines as follows:

- Show the story in parts. The number of elements in a loop should be determined by the needs of the story and of the people using the diagram. A simple description might be enough to stimulate dialogue and provide a new way to see a problem. In other situations, it may need more loops to clarify the causal relationships being surfaced.
• It may not be necessary to incorporate all possible variables from a system. In some cases, there are external elements that do not change, change very slowly, or whose changes are irrelevant to the problem at hand. You can unnecessarily complicate things by including such details may unnecessarily overcomplicate the CLD.
• Some of the most effective loops reveal connections or relationships between parts of the organization or system that the group may not have noticed before.
• Remind participants that the purpose of the diagram is not to describe every detail of the process, but to show those aspects of the feedback structure which led to the observed pattern of behaviour.
• Loops are shorthand descriptions of what we perceive as current reality; if they reflect that perspective, they are “right” enough.

4. Identify the polarity of variable relationships (20 min)

4.1 Interactive lecture:
Highlight: (Refer Session 4 PPT slides #21-26)
• Pick a starting variable in the CLD.
• Assess whether arrows between two variables indicate change in the same or opposite direction.
• For each “pair” of variables decide what would happen if variable “A” changed: would it result in a change in the same direction (+) or opposite direction (-) in variable “B”? 
• Label each arrow to indicate the direction of effect. If change is in the same direction use a “+” sign, and if the change is in opposite directions use a “-” sign.

Determine the polarity of the links

Determine the polarity of the links
Note: If it is difficult to determine the nature of the relationship – it might mean that there are two mechanisms through which one variable influences another – and this should be further explored in the system. It might require adding an interim variable or indicating delays.

4.2 Pair share activity: [10min]

Ask participants working in pairs to identify the polarity of the linkages in the subsystem provided.

Provide participants with Handout 4.2 Neonate Case Study CLD to determine the polarity of all the relationships between variables.

Debrief: Refer Session 4 PPT Slide#27

Highlight:
Check participant understanding of polarity by asking participants to “tell the story” describing what happens within the system as a variable “increases” or “decreases”.

Provide the handout.

4.2 Activity Resources:
1. Copies of Handout 4.2. Neonatal case study CLD
2. Handout 4.3 Neonatal case study CLD with polarity
OR can use VENSIM file (Session 4CLD_template.mdl)
5. Identifying feedback loops (30 min)

5.1 Interactive lecture:

Highlight:
Once the polarity of every relationship in the CLD is established the next step is to identify feedback loops in the system.

- Not all linkages will be part of a feedback loop. Feedback loops exist when the arrows are all “flowing” in a circular direction.

- Reinforcing loops: (Refer Session 4 PPT slide #29)
  - A reinforcing loop is one in which an action produces a result which influences more of the same action thus resulting in growth or decline at an ever-increasing rate.
  - Where feedback increases the impact of a change, we call this a Reinforcing Loop.
  - Positive reinforcing loops produce virtuous cycles.
  - Negative reinforcing loops produce vicious cycles.
  - Identify a reinforcing loop when:
    - All the arrows in the loop are “+” OR
    - If there is an even number of “-” arrows (irrespective of the number of “+” arrows)
  - Example provided (refer Session 4 PPT slide #30). As the supervisor supportive behaviour increases so employee performance increases which reinforces supervisor’s supportive behaviour which in turn reinforces employee behaviour – a virtuous reinforcing loop. Similarly as Supervisor’s supportive behaviour diminishes, employee performance declines, driving worsening supervisor support which further decreases performance – a vicious reinforcing loop.

- Balancing loops
  - Balancing loops generate the forces of resistance, which eventually limit growth, maintain stability, and achieve equilibrium.
  - Balancing loops reduces the impact of a change and are goal seeking.
  - Shortcut to determining a balancing loop:
    - Count the number of minus signs ( - ) in the loop: an odd number of minus signs = balancing loop
  - Example provided (refer Session 4 PPT slide #32). As the quality of care provided at the primary level changes (for the sake of this example, will use an increase in the quality of care) so research shows that utilization of the services will increase, driving an increase in workload. Since there is no compensating increase in staff coverage, the increased workload ultimately drives down staff motivation, which drives down the level of respectful care given, and ultimately diminishes the quality of care.
provided. This is typical of a balancing loop – despite change in quality of care, utilization is limited because of policy resistance demonstrated by staff behaviour. Without an increase in the number of staff this will continue as a balancing feedback loop.

5.2 Pair share activity: [10min]
Ask participants working in pairs to identify feedback loops in the subsystem provided.

Provide participants with Handout 4.3 Neonatal Case Study CLD with polarity to identify feedback loops and describe how these feedback loops influence the dynamics of the system.

Debrief: (Refer Session 4 PPT slides # 35 – 38)
- Discuss how these feedback loops drive the dynamics of the system and implications for interventions.
- Focus on the interaction between the reinforcing loops and two balancing loops in this sub-system.
- Step back and examine the feedback loops in the sub-system as they function in the larger CLD that has been elaborated. (refer Session 4 PPT slide # 39)
SESSION 4: SURFACING CAUSAL LOOP DIAGRAMS

Identify the feedback loops

Reinforcing Loop

Trust in the healthcare service → Mothers’ frustration (long waiting times, stock outs) → Resource adequacy (staffing, drugs, logistics and supplies) → Mothers attending ANC, hospital deliveries and PNC → Safe deliveries and PNC

Balancing Loop

Trust in the healthcare service → Mothers’ frustration (long waiting times, stock outs) → Resource adequacy (staffing, drugs, logistics and supplies) → Mothers attending ANC, hospital deliveries and PNC → Safe deliveries and PNC

Identify the feedback loops

Balancing Loop

Trust in the healthcare service → Mothers’ frustration (long waiting times, stock outs) → Resource adequacy (staffing, drugs, logistics and supplies) → Mothers attending ANC, hospital deliveries and PNC → Safe deliveries and PNC

Feedback loops
6. Identifying leverage points (30 min)

6.1 Interactive lecture:

Highlight: (Refer Session 4 PPT slide #41-43)

(Note: there is a lot of explanatory text for this section – facilitator should edit the text and slides according to the particular audience)

- A leverage point is a place in the system’s structure:
  - Where micro changes can result in macro results
  - When an intervention can be applied

- A low leverage point—small level of intervention or change force results in a small change in the behaviour of the system. Often used to address intermediate causes of a problem

- A high leverage point—small level of intervention/change force, causes a large change in the system’s behaviour. Used to resolve root causes.

- Donella Meadows\(^2\), in her work on leverage points identifies a hierarchy of levers that can be applied to change and strengthen a complex system ranging from low to high. These can be characterised into four groups (low to high levers) – physical, informational, social and conscious summarised in the table below.

- **Physical leverage** is focused primarily on a change in the physical amount of the elements/variables – focus on changing inputs and physical structures. While this is considered low leverage (and often most proximal to the outcome of interest) most change interventions are spent working with these kind of interventions. Meadows regards this as little more than “tinkering with a broken system”.

- **Informational leverage** recognizes that systems can be stabilized/destabilized by rate of change and information flows. Interventions at this level focus on strategies to reduce delays, optimize information flows, manage relationships between feedback loops; address resisting influence of balancing feedback loops, and strengthen reinforcing feedback loops to create virtuous cycles. Strategies to create new loops and connect different system elements are also part of this level of leverage points as they speed up information flows.

- **Social leverage** seeks to change the rules and goals of a system – changing what a system seeks to achieve and how. These changes might include changing rules like who is allowed to perform certain tasks, or incentive structures for people working in rural areas, or be higher level changes – such as changing the goal of the health system. By changing the goal, the rules will change and so the physical and informational structures that lie beneath the goal will also change, altering the system in more fundamental ways. For example, shifts in the primary goal from pure economic returns (e.g., focus on health care industry profits) to social ones, will result in financial returns being demoted to the status of a means rather than an end and greater focus placed on ends such as equity, and financial and social risk protection for people accessing health care. But, if the ultimate goal of the health

---

system is to maximize profitability of the health care industry, then all other sub-systems, feedback loops, information flows and behaviour within the system will be twisted to conform to that goal. By understanding the ultimate goal of the whole system, we can assess and understand how all other elements in the system function to conform to that goal. Intervening to shift whole system goal would be a high leverage point that affects change throughout the system.

<table>
<thead>
<tr>
<th>TYPE</th>
<th>LEVER</th>
<th>AIM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical</td>
<td>• Change physical amount of elements and stocks</td>
<td>• Focus on changing inputs</td>
</tr>
<tr>
<td></td>
<td>• Change structure of physical systems e.g.; staffing structures</td>
<td>• Focus on more proximal drivers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: Low leverage potential</td>
</tr>
<tr>
<td></td>
<td>• Change rate of system responses</td>
<td>• Reduce system delays</td>
</tr>
<tr>
<td></td>
<td>• Manage relationships and timing between feedback loops</td>
<td>• Examine stabilizing/ resisting influence of balancing feedback loops</td>
</tr>
<tr>
<td></td>
<td>• Create new loops to connect different system elements</td>
<td>• Reinforce virtuous feedback loops</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Explore and alter who has access to what information</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Social</td>
<td>• Alter rules of the system (such as incentives, punishments, constraints) to support desired goals</td>
<td>• Understand and change what the rules are and who has power over them</td>
</tr>
<tr>
<td></td>
<td>• Alter goals of the system - what a system seeks to achieve</td>
<td>• Nurture innovation, flexibility, variation and collaboration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: High leverage potential</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conscious</td>
<td>• Shift mind-set or paradigm out of which the system arises</td>
<td>• View whole system functioning and dynamics</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Expose anomalies and failures in old paradigm and challenge assumptions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Work with active change agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: Highest leverage potential</td>
</tr>
</tbody>
</table>
Conscious leverage seeks to change the mind-set or paradigm out of which the system arises. To affect this change requires challenging the assumptions about the way things are, and exposing the anomalies and failures in the old paradigm. Systems thinking tools model and expose all the complex system dynamics. This comprehensive view will highlight when there is a need for a fundamental shift in the behaviours driving the system. Strategies and interventions to shift mind-sets and paradigms include inserting people with new paradigm mind-sets in places of public visibility and power, and working with active change agents. A good example of a change in mind set occurred when the HIV/AIDS community accepted that people in Africa had a right to receive anti-retroviral therapy. This change in mind-set resulted in a fundamental change in how drugs were priced and procured, how health systems were organized, and how civil society engaged in the process. Challenging social, economic and political norms, and re-examining core-values represent leverage at the highest level, resulting in the largest change but will also face the most resistance from the existing system.

- Thinking about the hierarchy of leverage points, there are a number of intervention strategies that can be used depending upon the specific characteristics of the dynamics in a particular system, and the level at which the stakeholder wishes to intervene. (Refer Session 4 PPT slide # 44)

- Identification of leverage points and appropriate intervention strategies should be accompanied by an examination of potential areas of policy resistance or unintended consequences that might occur following implementation of selected strategies. (Refer Session 4 PPT slide # 45). Strategies to mitigate policy resistance include adding new links or loops (new behaviours), breaking, weakening, or strengthening a link, changing delays or altering the polarity of a link.

<table>
<thead>
<tr>
<th>Leverage Points and intervention strategies</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System Dynamic</strong></td>
</tr>
<tr>
<td>System is stagnant or stalled</td>
</tr>
<tr>
<td>Vicious cycles</td>
</tr>
<tr>
<td>Re-examine feedback cycle</td>
</tr>
<tr>
<td>Find the strongest feedback structure</td>
</tr>
</tbody>
</table>

Overcoming policy resistance
Examine CLD for potential policy resistance following strategy implementation.
Develop “what if” alternatives to mitigate policy resistance by:
- Adding a new link or loop — can the system start doing something differently or new?
- Breaking or strengthening a link between two variables — can the system stop doing something or do less of something.
- Breaking a link and hence a loop — can the system do more of something that was working.
- Alter delays.
- Switching an + to an - (or vice versa) on the link from one variable to another — by getting the system to behave in a different way.
6.2 Pair share activity: [10min]
Ask participants working in pairs to examine the neonatal case study CLD to identify leverage points, possible intervention strategies, and potential policy resistance. Use Handout 4.3 for this exercise or Session 4 PPT slide #46.
(Note: this is not meant as a substantial activity but rather to reinforce some of the concepts covered in this session. These skills are further developed Session 5, with an application of these skills to a specific case study).

Debrief:
Provide participants with an approach to examining CLDs. *(Refer Session 4 PPT slides # 47)*

Highlight:
- CLDs developed to better understand the complex dynamics driving a particular issue in a given situation.
- As more and more CLDs are being developed it is important to develop an approach to reviewing CLDs with the intent of using these models to understand the system before intervening.
- Key questions to ask when examining any CLD:
  - What was the purpose or underlying issue driving the development of this CLD?
  - From what reference level or perspective has this CLD been developed?
  - What information was used to construct the CLD?
  - What process was used to construct the CLD – specifically how were people’s mental models and assumptions made explicit?
  - What are the key variables of interest/key outcomes in this CLD?
  - What are the main drivers – proximal and distal and how do they link together?
  - Can you identify the major feedback loops in this CLD and how do these loops interact to give rise to the system behaviour?
  - Thinking about intervening in the system – what is your scope of influence and how does this impact the level of leverage possible (thinking about the Meadows characterization)? What is the range of strategic interventions possible and how would these impact the system if successfully implemented?
  - What are possible points of policy resistance and how might those be mitigated given the specific system dynamics?
  - Finally – consider the boundaries of the system – how were these determined? Whose voices are included in the system and who is left out? What additional elements should be included?
7. Wrap up and questions (10 min)

Highlight:

- Briefly review the various systems tools that have been introduced and the purpose of these tools.
- Review tools from Rich Pictures, through to IRDs, and then CLDs. *(Refer Session 4 PPT slide # 48)*

### How do we use Systems Thinking Tools?

- Explain root problems, their drivers and feedback mechanisms
- Identify potential leverage points for interventions
- Explore appropriate intermediate and outcome measures
- Model the potential impact of system interventions
- Identify potential policy resistance
- Formulate appropriate research questions
- Make explicit our theory of change
SESSION 4 ADDITIONAL RESOURCES


SESSION 5: APPLYING SYSTEM THINKING TOOLS

This session draws upon work covered in previous sessions and provides an opportunity to apply systems thinking skills to a case study, highlighting the use of causal loop diagrams to understand and intervene in a complex health system.

Total session time: 70 minutes

Session Objectives:
By the end of the session, participants will be able to:
- Interpret causal loop diagrams and describe the system dynamics using principles of complex adaptive systems
- Identify leverage points from a causal loop diagram
- Use a causal loop diagram for inference regarding health system interventions

1. Introduction to goals of the session (5 min)
This session is planned as a discussion section based on the Rwashana case study.
Explain: (PPT Slide #3)
- The intention is to apply learning and skills from Session 1 – 4 to deepen understanding of the findings and CLDs presented in the Rwashana case study.
- Stepping back from the case study, participants should be able to use CLDs to examine the intricate dynamics within the system.
- Use this understanding to identify leverage points to intervene in the short and long term.
- Through this process anticipate the potential for unintended consequences and policy resistance and how these might be mitigated, given the systems dynamics.

2. Small group discussion (30min)
Participants divide into groups of 4-5 to discuss the supply and demand CLDs using the guiding questions provided as part of the participant case briefing document (Handout 5.1).

This activity is divided into three sections: discussion of demand CLD (questions 1-3), discussion of supply CLD (question 4-5), and identification of strategies and policy resistance (question 6). The facilitator can elect to debrief after each section, or allow groups to work through all three sections before debriefing in plenary.

(Refer to Session 5 PPT slides # 4, 5, 7, 8, 10) for activity set up.

Resources required:
1. PowerPoint slides for Session 5 (Note: Handouts of PPTs to be provided at end of session)
2. Handout 5.1 Participant case brief
3. Facilitator Note 5.1
3. Plenary conversation about CLDs (25 min)

Facilitator leads feedback session. To limit feedback time but maximize participation ask the group to contribute one point in response to each question. Below are some points to highlight as part of discussion.

Examine the demand CLD. *(Refer Session 5 PPT slide # 5)*:

**Questions**

1. Identify linkages and polarities; what key messages emerge?
2. Identify the key drivers of the risk of neonatal death “death risk of neonate” and discuss how these drivers are interlinked
3. Identify any additional feedback loops—are they balancing or reinforcing?

**Highlight:**

- **Key drivers of neonatal death** – examine both proximal and distal drivers and implications for intervention at different levels of the system.
  - The death risk of a neonate increases with:
    - hypothermia,
    - poor breast feeding practices,
    - poor socioeconomic status, and
    - poor care of the neonate resulting from lack of awareness.

- **Additional key feedback loops:** *(Refer Session 5 PPT slide # 6)* (for more detailed description of system dynamics refer to Facilitator note 5.1)
  - One balancing loop (B1, frustration loop) where there is an attempt to achieve the goal of increasing uptake of maternal health service
  - Four reinforcing loops (R1, awareness loop; R2, trust loop; R3, myths loop; and R4, health loop)

- **Discuss the interaction amongst these feedback loops:**
  - Neonatal health depends on the health of the mothers which can be increased by:
    - increased self and household hygiene,
    - increased level of awareness,
    - attendance to ANC, PNC, and health facility deliveries, and
    - adherence to the recommended nutrition.
  - Factors that lower the mothers’ health include:
    - increased frequency of child delivery,
    - diseases such as malaria, and,
    - teenage pregnancies, among others.

Examine the Supply CLD *(Refer Session 5 PPT slide # 8)*
**SESSION 5: APPLYING SYSTEM THINKING TOOLS**

**Questions:**
4. What key messages emerge?
5. Identify at least one feedback loop, and describe the loop and its impact on the system

**Highlight:**
- Additional feedback loops: PPT Slide #9 (for more detailed description of system dynamics refer to Facilitator note 5.1)
  - One reinforcing loop (R5, motivation loop) that represents a growing action in the motivation of the workforce.
  - Four balancing loops (B2, transport loop; B3, workforce loop; B4, logistics loop; and B5, workload loop) all representing desired goals towards improvement in the supply of maternal health service.

**Increasing newborn survival - Identification of leverage points:**

**Question 6: Using both the supply and demand causal loop diagrams.**
- **Identify key leverage points aimed at increasing newborn survival - from the following stakeholder positions. Minister of Health (National policy level); Clinic manager; Non-Governmental Organization (NGO) working at community level.**
- **Provide a rationale based on the CLDs for your decisions.**
- **Explain how intervening at this point would influence the system.**
- **Identify potential sources of policy resistance.**

**Note:** Refer back to session 4 PPT slides# 41 – 45 for discussion regarding leverage points and overcoming policy resistance
Highlight:

- Identify potential low and high leverage points. (For more detailed description of potential leverage points refer to Facilitator note 5.1).
- Low leverage points – address intermediate/proximal drivers of neonatal death versus high leverage points that would address more distal/root causes of neonatal deaths.
- Decision regarding specific strategies to intervene at select leverage point should be informed by stakeholder sphere of influence.
- Leverage points: (PPT slides # 11, 12)
  - Increased awareness on maternal and neonatal healthcare – weakens vicious cycle exhibited by myths loop (R3) while strengthening the virtuous cycle of the awareness loop (R1).
  - Improving socio-economic status is a high leverage point, but may be outside of the sphere of influence for some stakeholders.
  - Funding for maternal and neonatal health care would minimize frustration loop (B1) and strengthen virtuous cycle created by motivation loop (R5).

4. Wrap up and reflection (10 min)

Facilitator summarizes key points arising from discussion.
Prompt participants to reflect on the following questions: (These reflections can be done in class or in their own time).

- What are the implications of feedback loops for determining leverage points?
- What insights do these CLDs provide that might have otherwise been missed?
SESSION 5 ADDITIONAL RESOURCES

## SECTION THREE COURSE HANOUTS

<table>
<thead>
<tr>
<th>Handout Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Handout 2.1 Sorting Laundry Worksheet</td>
<td>63</td>
</tr>
<tr>
<td>Handout 2.2 Participant - Case Study Summary</td>
<td>64</td>
</tr>
<tr>
<td>Handout 3.1 Interrelationship Digraph Template</td>
<td>65</td>
</tr>
<tr>
<td>Handout 3.2 IRD Drivers and Outcomes Determination</td>
<td>66</td>
</tr>
<tr>
<td>Handout 4.1 Causal Loop Diagram Template</td>
<td>67</td>
</tr>
<tr>
<td>Handout 4.2 CLD Feedback Loop Template</td>
<td>68</td>
</tr>
<tr>
<td>Session 5: Applying Systems Thinking Tools</td>
<td>69</td>
</tr>
<tr>
<td>Handout 5.1 Participant - Case Brief</td>
<td>69</td>
</tr>
<tr>
<td>Facilitator Note 5.1 – Understanding the System Dynamics</td>
<td>74</td>
</tr>
<tr>
<td>Worksheet: Downloading and Installing Vensim</td>
<td>80</td>
</tr>
<tr>
<td>Guidance Note: How to Use Vensim to Create CLDs</td>
<td>82</td>
</tr>
</tbody>
</table>
HANDOUT 2.1 SORTING LAUNDRY WORKSHEET

Instructions: Work on your own. Use the laundry baskets in the table below to sort the following laundry items into piles ready for washing (“drop” the numbers /item names into appropriate baskets – use the back of the page if you sort into more than 10 piles)

1. Navy button-up dress shirt (designer)
2. Jeans (denim, new)
3. Red T-shirt (washed once)
4. Three white tank tops (cotton)
5. Athletic shorts (do not tumble-dry)
6. Bath mat
7. Fleece jacket
8. Blazer (black)
9. Soccer socks (very smelly)
10. Football pants (originally white but covered with mud)
11. Football jersey (red and blue striped; also very muddy)
12. White socks
13. Grey cable knit sweater (dry clean only)
14. Tights (black, 3 pairs)
15. Nylons (2 pairs)
16. Yankees baseball jersey
17. Four towels, - two yellow, one red-striped, one white
18. New purple underwear/boxers
19. Wool cardigan (dry clean only)
20. Dark blue sweat pants and sweatshirt
21. Oily kitchen towels
22. Grey t-shirt
23. Boxer shorts - patterned
24. Grey dress trousers
25. Trench coat (cold water wash)
26. Khaki pants (do not tumble-dry)
27. Beaded sweater with sequins
28. Cashmere sweater (dry flat, do not spin or wring)
29. Pajamas (silk)
30. Jeans (denim, torn with patches)
Addressing Neonatal Mortality in Uganda Case Study

Despite global efforts to improve child survival and maternal health, over three million babies die every year within the first month of life indicating insufficient focus of those efforts toward neonates. Uganda holds the fifth highest rate of neonatal mortality, losing 43,000 neonates every year. While neonatal mortality has been reduced globally, the rate of decline in Uganda has stagnated during the past two decades, highlighting that programs currently targeting neonatal health are not adequately addressing causes of neonatal death.

The health and survival of a baby throughout the first 28 days of life is determined by a complex network of factors that exert influence even before the child is born. Factors determining a mother’s knowledge, attitudes, and practices surrounding health, combined with factors regarding the supply of accessible, appropriate, and quality care collectively determine a neonate’s chances of survival.

DEMAND SIDE ISSUES

Evidence shows that the health of a mother throughout pregnancy, and even before pregnancy, is highly associated with her baby’s survival, especially during the neonatal period. Babies born to mothers with pre-existing conditions that are prevalent in Uganda, such as HIV and malaria, are more likely to die within the first month of life. Within Uganda, the majority of women are unable to achieve the minimum number of visits to a health facility during antenatal care, delivery, and postnatal care that are recommended by the World Health Organization to ensure the health of the mother and her baby. Often this is due to distance from a health facility, lack of available transportation to a health facility, lack of money to pay for transport or care, competing work and household priorities, and low knowledge of the importance of these health visits. Even when women understand the importance of health facility visits, are able to garner the resources to access a facility, and are able to allocate the time, lack of confidence and trust in the health system to provide adequate, high quality, and respectful care still deters them from achieving essential visits.

SUPPLY SIDE ISSUES

The perceptions of mothers that the Ugandan health system may be unable to provide effective maternal and neonatal care are not unwarranted. The number of available facilities is insufficient to meet the needs of the population. Further, many of the available facilities lack vital medications, supplies, equipment, and commodities—even those as basic as electricity and water supply. Hygiene is poor within facilities, leading to unnecessary and often fatal infections in neonates. These factors combined with poor training, low compensation, demanding hours, and lack of supervision contribute to low motivation within the health workforce to provide high quality care. Health record keeping such as birth and death registries often fail to capture these events, therefore misrepresenting the status of neonatal health and survival within Uganda to governmental authorities and international stakeholders. Only through identification of these influencers and characterization of their relationships can Uganda’s stagnating neonatal mortality be explained and ultimately addressed to improve neonatal survival.

SESSION 3: CREATING INTERRELATIONSHIP DIGRAPHS

HANDOUT 3.1 INTERRELATIONSHIP DIGRAPH TEMPLATE

- mothers attending ANC, hospital deliveries and PNC
- perceptions and belief in myths
- health education by health workers
- mothers' birth preparedness
- neonatal survival
- resource adequacy (staffing, drugs, logistics and supplies)
- socio-economic status
- safe deliveries and PNC
- level of awareness of MHC and NHC
- health of mothers
- care of newborns
- death risk of neonate
SESSION 3: CREATING INTERRELATIONSHIP DIGRAPHS

HANDOUT 3.2 INTERRELATIONSHIP DIGRAPH DRIVERS AND OUTCOMES DETERMINATION

- mothers attending ANC, hospital deliveries and PNC
- perceptions and belief in myths
- health education by health workers
- mothers' birth preparedness
- neonatal survival
- socio-economic status
- resource adequacy (staffing, drugs, logistics and supplies)
- safe deliveries and PNC
- level of awareness of MHC and NHC
- health of mothers
- care of newborns
- death risk of neonate
SESSION 4: SURFACING CAUSAL LOOP DIAGRAMS

HANOUT 4.1 CAUSAL LOOP DIAGRAM TEMPLATE

- Mothers' birth preparedness
- Mothers attending ANC, hospital deliveries and PNC
- Mothers' frustration (long waiting times, stock outs)
- Resource adequacy (staffing, drugs, logistics and supplies)
- Socio-economic status
- Trust in the healthcare service
- Safe deliveries and PNC
- Neonatal survival
- Health of mothers
- Health of newborn
- Care of newborn
- Health education by health workers
- Level of awareness of MHC and NHC
- Perceptions and belief in myths
- Mothers' birth preparedness
SESSION 4: SURFACING CAUSAL LOOP DIAGRAMS

HANDOUT 4.2 CLD FEEDBACK LOOP TEMPLATE

Mothers attending ANC, hospital deliveries and PNC
level of awareness of MHC and NHC
health of mothers
death risk of neonate
safe deliveries and PNC
trust in the healthcare service
Mothers' frustration (long waiting times, stock outs)
resource adequacy (staffing, drugs, logistics and supplies)
socio-economic status

e+p

+ +

health of mothers

perceptions and belief in myths
care of newborn

+ +

neonatal survival

health education by health workers

mothers attending ANC, hospital deliveries and PNC
mothers' birth preparedness

level of awareness of MHC and NHC
SESSION 5: APPLYING SYSTEMS THINKING TOOLS
ADDRESSING NEONATAL MORTALITY IN UGANDA CASE STUDY

HANDOUT 5.1 PARTICIPANT - CASE BRIEF.

Case Study: 5 pages total

BACKGROUND

Of the three million newborns that die each year, 99% occur in low- and middle-income countries. Despite child survival and safe motherhood programmes towards reducing child mortality, insufficient attention has been given to this critical first month of life. Three quarters of these neonatal deaths occur within the first week of life and at least 1 million die on the first day of life. There is urgent need to innovatively employ alternative solutions that take into account the intricate complexities of neonatal health and the health systems.

In this study the researchers set out to empirically contribute to understanding the causes of the stagnating neonatal mortality by applying a systems thinking approach to explore the dynamics arising from the neonatal health complexity and non-linearity and its interplay with health systems factors.

The study was conducted using a low income country in sub-Saharan Africa as a case study.

METHODS

Preliminary information related to neonatal mortality and the associated problems was collected from peer-reviewed literature as well as global and local reports and policy documents in order to understand and better characterize the current problems influencing neonatal health.

Semi structured interviews conducted with:

- mothers at antenatal clinics and at home,
- village health workers,
- community leaders,
- healthcare decision and policy makers, and
- frontline health workers from both public and private health facilities.

---

Data analysis and brainstorming sessions were used to develop causal loop diagrams (CLDs) depicting the causes of neonatal mortality, which were validated by local and international stakeholders.

VALIDATION OF THE CAUSAL LOOP DIAGRAMS

Validation of the CLDs and the underlying conceptual thinking was carried out by local and international neonatal and maternal health stakeholders, including both researchers and implementers. Respondents were asked to state whether all the variables and relationships in the CLDs existed and whether there were any significant causal factors missing.

RESULTS

Based on the findings, two CLDs were developed, for demand and supply side issues, depicting the range of factors associated with neonatal mortality such as maternal health, level of awareness of maternal and newborn health, and availability and quality of health services, among others.

This study presents the first of its kind in-depth analysis of the possible causes of neonatal mortality in a given context with an explicit focus on complexity. The researchers explicitly examined the feedback loops that were generated due to the complexities surrounding neonatal mortality as a first step towards considering and testing alternative short- and long-term strategies that may be used to efficiently address the root causes of some of these problems.
CAUSAL LOOP DIAGRAM SHOWING THE DEMAND FOR NEONATAL AND MATERNAL HEALTH SERVICE DELIVERY.
CAUSAL LOOP DIAGRAM SHOWING THE SUPPLY OF NEONATAL AND MATERNAL HEALTH SERVICE DELIVERY.
SESSION 5: APPLYING SYSTEMS THINKING DISCUSSION SECTION

GUIDING QUESTIONS:

Examine the CLD showing the **demand** for neonatal and maternal health services

1. Identify linkages and polarities; what key messages emerge?
2. Identify the key drivers of the risk of neonatal death “death risk of neonate” and discuss how these drivers are interlinked
3. Identify any additional feedback loops—are they balancing or reinforcing? How do the feedback loops interact with each other?

Now examine the CLD showing the **supply** of neonatal and maternal health services

4. What key messages emerge?
5. Identify at least one feedback loop, and describe the loop and its impact on the system

Examining both CLDs and thinking about how to increase newborn survival:

6. Identify key leverage points from the following stakeholder positions and provide a rationale for your choice. Explain how intervening at this point would influence the system and identify potential sources of policy resistance.
   a) Minister of Health (National policy level)
   b) Clinic manager
   c) NGO working at community level
SESSION 5: APPLYING SYSTEMS THINKING TOOLS
ADDRESSING NEONATAL MORTALITY IN UGANDA CASE STUDY

FACILITATOR NOTE 5.1 – UNDERSTANDING THE SYSTEM DYNAMICS

Note: text below is extracted directly from the Rwashana paper

(Note: Total 6 pages)

DYNAMICS OF THE DEMAND FOR NEONATAL AND MATERNAL HEALTHCARE SERVICE

We identified one balancing loop (B1, frustration loop) where there is an attempt to achieve the goal of increasing uptake of maternal health service and four reinforcing loops (R1, awareness loop; R2, trust loop; R3, myths loop; and R4, health loop) that represent growing actions as illustrated below.

The awareness loop (R1 - REINFORCING) is a virtuous cycle that enhances the growth of awareness. The level of awareness of neonatal and maternal health issues results in improved health of mothers and increased attendance to neonatal and maternal healthcare services, thereby lowering the death risk of neonates. Awareness is enhanced through health education programmes provided during ANC visits, media (TV, radio, newspapers), sensitization by community leaders, and word of mouth through peer to peer interactions among mothers. As mothers attend ANC, PNC, and hospital deliveries, the level of awareness increases resulting in mothers’ preparedness for birth. Mothers’ birth preparedness, which is achieved with increased level of awareness, family and community support, and socio-economic status increases the likelihood of attending health services and therefore having safer deliveries, and further enhances the attendance to ANC. The growth in the awareness loop eventually slows down due to the inadequacy of resources exhibited in the frustration loop resulting into the limits to growth archetype (loops R1 and B1). In order to avoid the limits to growth, the quality of service in the health facilities must be sustained.

The trust loop (R2 - REINFORCING) enhances the trust of women in health systems through provision of safe health care deliveries and PNC. As more mothers attend ANC, hospital deliveries, and PNC, the level of safe deliveries and PNC increases, which in turn increases their trust in the healthcare service. The growth in the trust loop eventually encounters limiting action thereby exhibiting the limits to growth archetype (loops R2 and B1). The limits to growth of this cycle arises from inadequate resources that are needed to sustain the quality of maternal and neonatal healthcare service deliveries as exhibited in the frustration loop (B1) explained below. In order to maintain the trust, the quality of the maternal and neonatal service must be observed.

The frustration loop (B1-BALANCING) shows that the desired state is to have as many mothers attending ANC, healthcare deliveries, and PNC. Attendance to ANC and delivering at health facilities...
plays a big role in promoting safe deliveries and obtaining PNC, which will also contribute to increased trust in the health system and improving the general awareness about the benefits of these health services in the community. When the number of women participating in maternal and neonatal health services increases, the resources (staff, drugs, logistics, and supplies) in the health facilities are depleted, leading to frustration resulting from effects of poor service delivery such as long waiting times and drug stock outs, which results in a decrease in attendance, thus demonstrating a balancing loop. Efforts should be made to ensure that the resources in the health facilities match the demand, thereby minimising frustration of mothers.

The myths loop (R3-REINFORCING) produces a desirable effect whereby beliefs in myths are decreasing. As the level of awareness on maternal health care (MHC) and neonatal health care (NHC) increases, belief in perception and myths decreases. As the belief in perceptions and myths decreases, the level of awareness increases. Belief in myths and perceptions that are enhanced as a result of low maternal literacy levels are a hindrance to the level of awareness. Efforts to keep the growth of awareness through community and peer to peer sensitization, health education, and media should be made so that eventually the myths die off.

The healthy mothers loop (R4-REINFORCING) produces a virtuous cycle where mothers’ attendance to ANC and hospital deliveries results in improved mothers’ health, thereby producing safe deliveries, which builds trust resulting in a further increase in the mothers’ uptake of health services. This loop interacts with the frustration loop creating the limits to growth archetype.

The CLD shows that neonatal health heavily depends on the health of the mothers. The health of the mothers can be increased by increased self and household hygiene, increased level of awareness, attendance to ANC, PNC, and health facility deliveries, and adherence to the recommended nutrition. Factors that lower the mothers’ health include increased frequency of child delivery, diseases such as malaria, and teenage pregnancies, among others. The death risk of a neonate increases with hypothermia, poor breast feeding practices, poor socioeconomic status, and poor care of the neonate resulting from lack of awareness.
In this CLD, one reinforcing loop (R5, motivation loop) that represents a growing action in the motivation of the workforce and four balancing loops (B2, transport loop; B3, workforce loop; B4, logistics loop; and B5, workload loop) all representing desired goals towards improvement in the supply of maternal health service are identified and explained below.

The transport loop (B2- BALANCING) emphasizes the importance of having timely and adequate referrals between hospitals towards improvement of the maternal and neonatal healthcare services, which can be achieved through the provision of transport/ambulances. As the funding for maternal and neonatal healthcare increases, provision of ambulances and transport increases, resulting in timely and adequate referrals between health units. This improves maternal and neonatal healthcare service delivery which lowers the death risk of neonates and in turn lowers neonatal mortality rates. A rise in neonatal mortality rates attracts an increase in advocacy initiatives resulting in increased funding. Funding for purchase and maintenance of vehicles as well as policies for use of these vehicles should be done.
The workforce loop (B3-BALANCING) shows that the desired state is to have a motivated workforce in terms of having the right skills, remuneration, and attitude. An increase in the funding for maternal and neonatal healthcare results in an increase in the training, recruitment, and remuneration of health workers, resulting in a motivated workforce. This improves maternal and neonatal healthcare service delivery, which lowers the death risk of neonates and in turn lowers neonatal mortality rates. A rise in neonatal mortality rates attracts an increase in advocacy initiatives resulting in increased funding. For this to happen, governments must be willing to fund and invest in the training, recruitment, and remuneration of health workers. Failure to do so eventually results in poor maternal and neonatal healthcare, thereby increasing the death risks of neonates and resulting in increased neonatal mortality.

The logistics loop (B4-BALANCING) shows that the desired state is to have quality maternal and neonatal health services where the health facilities have logistics, drugs, and resuscitation kits. As the funding for maternal and neonatal healthcare increases, provision of infrastructure, diagnostic and resuscitation kits, drugs, and logistics and logistical support increase. This improves maternal and neonatal healthcare service delivery, which lowers the death risk of neonates and in turn lowers neonatal mortality rates. A rise in neonatal mortality rates attracts an increase in advocacy initiatives resulting in increased funding. Governments should provide adequate funding to ensure that the required resources are made available.

The motivation loop (R5-REINFORCING), together with the workload loop (B5), make up a limits to growth archetype. Limits to growth of this loop result from exceeding the capacity of mothers that can be handled by the workforce. The motivation loop shows that a motivated workforce that is well supervised, remunerated, and trained, and with adequate supplies will increase the maternal and neonatal healthcare service delivery. When the service delivery is good, this, in turn, further motivates the staff resulting in a virtuous cycle. The workload loop (B5), on the other hand, shows that an increase in a motivated workforce increases the number of mothers attending ANC, hospital deliveries, and PNC, which in turn increases the workload thus lowering the workforce that is motivated. It is therefore important that the health services and workforce are upgraded to meet the growing population which will even out the number of patients attending the few health facilities.

With adequate financing of maternal and neonatal health services, the following can be made available: training, recruitment, and adequate remuneration of health workers, resulting in a motivated workforce providing quality healthcare service and thus leading to safe deliveries; transport for timely and adequate referrals between health units and obtaining blood bags if necessary; and equipment (e.g., for resuscitation, suction or oxygen), medical supplies, emergency drugs, and safe delivery kits. The availability of funding coupled with good governance is necessary for the formulation and enforcement of healthcare guidelines, planning, supervision, and efficient and equitable resource allocation, as well as monitoring and evaluation and audits of health facilities. Although the graph in Figure 1 demonstrates that the skilled birth attendance has increased slightly there has not been significant decline in neonatal mortality rates over the past two decades. This clearly brings out the various limits to growth loops identified in the CLDs, which show that as the limits to growth are reached, the growth engine loses its effectiveness, and the growth curve begins to flatten.
LEVERAGE POINTS (STUDENTS MAY IDENTIFY OTHERS)

Leverages are influences within the system where small changes can effect a substantial change in the system. From the analysis of the CLDs, the following were perceived as high leverage points which can effect significant improvement in neonatal healthcare:

- **Increased awareness on maternal and neonatal healthcare** can weaken the vicious cycle exhibited by the myths loop (R3) while strengthening the virtuous cycle of the awareness loop (R1). Mothers’ awareness on the recommended feeding, nutrition, hygiene, household environment, and mothers’ birth preparedness and efforts to avoid untreated diseases results in improved health of the mothers, which in turn lowers neonatal mortality rates. Some of the short-term interventions which may improve awareness include aggressive advertising, campaigns, sensitization, and education of the women and girl child as well as increasing the effectiveness of the health education sessions during ANC and PNC. Special gender considerations to ensure that girls receive essential education thereby increasing maternal mortality rates is a longer term strategy but would synergistically address many other health and non-health issues.

- The low socio-economic status is a key determinant in the health of the mothers and the neonates. With improved socio-economic status, mothers are able to obtain the recommended nutrition, healthcare, and the requirements for birth preparedness. While introducing incentives, such as transport vouchers and free birth kits for pregnant women, would motivate them to attend
ANCs and enable them to be better prepared for health facility deliveries in the short term, the government should work towards improving the socioeconomic status of the nation.

- **Funding for maternal and neonatal health care** should be prioritized at the national level. Efforts by the government and policy makers to upgrade the health service infrastructure as well as build systems for monitoring the resources (staffing, drugs, and stocks) would go a long way in minimizing the effects arising out of the frustration loop B1. Improved maternal and neonatal health service delivery will strengthen the virtuous cycle created by the motivation loop R5. In addition, without a motivated health work force that is well trained, adequately remunerated, and with an acceptable workload there is not much to be expected in terms of the quality of the care provided nor the likelihood that mothers will come to seek care at health facilities. Other short- and long-term strategies may include improved supervision and internal audits at health facilities to ensure that maternal and neonatal guidelines are adhered to as well as establish the current conditions and gaps in resources (human, logistics, and drugs) to guide the funding for national health care.

Step Two: You will be taken to the downloads page. Once there:

- Click on the anti-spam box
- Select Product Vensim PLE 6.3
- Select your appropriate platform (Mac or PC)
- Enter your name and email address
- Click on “download software"
Step Three – Installing the software

• You will receive an email with a link to the software

• Click on the link, download and save the program, and run the program installation

• Accept the terms and conditions

When presented with the Vensim PLE Install Options window - make sure you select the first option “Install Vensim PLE for academic, public research or personal use...”

Follow online instructions to complete the installation.
GUIDANCE NOTE: HOW TO USE VENSIM TO CREATE CLDS

TABLE OF CONTENTS

About this Guidance Note ................................................................. 83
Tips for Using Vensim ........................................................................ 83
  Mouse Tips ....................................................................................... 84
Drawing a Causal Loop Diagram using Vensim ................................... 85
  Project Model (primary care.mdl) ...................................................... 85
  Adding Variables ............................................................................ 85
  Moving Sketch Objects ................................................................... 85
  Adding Arrows .............................................................................. 87
  Handles ......................................................................................... 88
  Curved Arrows ............................................................................. 88
  Editing Variables ........................................................................... 89
  Deleting Variables ......................................................................... 90
  Undo and Redo ............................................................................. 90
  Saving Your Model ......................................................................... 90
Modifying diagrams ........................................................................... 90
  Selecting Sketch Objects ................................................................ 90
Sketch Options ................................................................................... 91
  Variables ....................................................................................... 91
  Arrows .......................................................................................... 91
  Adding Comments and Graphics .................................................... 95
Printing and Exporting the Sketch ...................................................... 96
Structural Analysis of Diagrams .......................................................... 97
  Analysis Tools ................................................................................ 97
  Causal Tracing® with Trees ............................................................. 98
  Causes Tree Diagram ..................................................................... 98
  Loops Tool ..................................................................................... 100
GUIDANCE NOTE: HOW TO USE VENSIM

ABOUT THIS GUIDANCE NOTE

*VENSIM* is one of several commercially available programs that facilitate the development of continuous simulation models known as system dynamics models. This note is intended to introduce you to the features of VENSIM software used to build causal loop diagrams. At this stage we will not be building or running any quantitative simulation systems dynamics models. This guidance note will NOT cover the process of developing CLDs — this will be covered during the course sessions.

TIPS FOR USING VENSIM

When a Sketch Tool is selected, that tool remains active until you select another tool. A single click (press and release) with the mouse button applies the tool to the sketch.

The **Lock** tool provides the standard mouse cursor. The Lock tool can be used for selecting sketch objects (they highlight black) and for changing options. Sketch objects cannot be moved with the Lock tool. Tip — you can select the Lock tool by pressing the Esc key, or the keyboard number 1.

The **Move/Size** tool is used for moving sketch objects around, including resizing variables and boxes, and reshaping arrows. The other sketch tools also allow you to move objects.

Variable sketch tools (**Variable** and **Box Variable**) and other variable tools you may configure) and the default setting for the **Rates** tool bring up editing boxes (for naming the Variable or Rate) when applied to the sketch. The **Sketch Comment** tool brings up a dialog box.

The **Arrow** tool starts an arrow. To do this make a single click (press and release) of the mouse button on the middle of the starting word, then finish with another single click on the middle of the ending word. Arrows (curved) can take one intermediate point on a sketch with an extra mouse click.

**NOTE** Do not try to draw arrows by clicking and holding the mouse button down while dragging the mouse. This will just move the word you are starting from. The same applies for rates.

Objects in a sketch can have their appearance changed by clicking on them with the right mouse button, which brings up an options dialog box.
To change the appearance (font, shape of box, etc.) of objects in your sketch, right click on them to bring up an options dialog box.

**Mouse Tips**

- If a mouse button click is called for without mention of left or right, use the left button (Macintosh, use the only button).
- If a mouse right button click is called for, with the Macintosh, hold down the Control key or the Apple key and click (Ctrl + Click or ⌘ + Click).
DRAWING A CAUSAL LOOP DIAGRAM USING VENSIM

PROJECT MODEL (PRIMARY CARE.MDL)

- Start Vensim: Vensim will open with the last model you worked on active
- Select the menu item File>New Model or click the New Model button on the Toolbar.

The Model Settings dialog box opens:

- Click OK to accept the default values
- Click the Save button on the Toolbar. Title your file primary care.

Adding Variables

- Click on the Variable tool
- Click in the middle top of the sketch and type “utilization of primary care services” in the editing box, then press Enter.
- Click on the Variable tool and continue filling out the diagram with the following variables: “user fee charges”, “access to care”, “staff motivation”, “staff remuneration”, “quality of care at primary level”, and “staff workload”.

Moving Sketch Objects

- Select the Move/Size tool (you can also press the keyboard number 2). Click on a variable, hold the mouse button down, and drag the variable to where you want it.
- You can also move and reposition objects using other sketch tools. Select the Variable tool again. Click on a variable. Press down and hold the mouse button, then drag the variable to a new position.
Position the variables as shown in the diagram above.

Vensim includes menu commands to help you lay out your sketch in a tidy manner. These commands allow you to resize sketch objects to default values, line up objects by position with a "last-selected" object, size objects to the last-selected, and more.

We can tidy the diagram up a bit:

- Click on access to care then hold the Shift key down and click on user fees. Select menu Layout>Vertical on LastSel. Access to care will move to line up on the center of user fees.
- Click on staff remuneration then hold the Shift key down and click on quality of care. Select menu Layout>Vertical on LastSel.
- Click on staff motivation then hold the Shift key down and click on workload. Select menu Layout>Vertical on LastSel.
- Click on staff remuneration then hold the Shift key down and click on user fees. Select menu Layout>Right Align on LastSel.
- Click on access to care then hold the Shift key down and click on quality of care. Select menu Layout>Left Align on LastSel.
Your diagram should now look something like this:

Adding Arrows

The existence (or lack) of user fees influences people’s use of primary care services. To show this influence in Vensim we can use arrows that indicate how one variable drives/causes a change in another variable.

- Select the **Arrow** tool by clicking on it (or press the keyboard number 5). Single click on *user fees*. Then single click on *utilization of primary care services*. A straight arrow will join the two variables pointing from *user fees* to *utilization of primary care services*.
- Follow this method for the rest of the variables as demonstrated in the example below.
Handles

Handles are the little circles that appear in the middle of arrows, and at the corner of boxes and clear boxes, in the middle of rates and elsewhere. These handles allow you to resize or move things around. These handles appear when first entering variables, when creating arrows, and any time the Move/Size tool is selected. Handles can be manipulated by the Move/Size tool or any other sketch tool except Lock.

- Select the Move/Size tool to turn handles on.

Curved Arrows

One Way: Dragging the handle

- Select the Move/Size tool. Click on the handle, hold the mouse down, and drag the handle to make a curved arrow.
Another Way: Three clicks

- Select the **Arrow** tool. Click once on your first variable, then click again midway between your first and second variable, and then finally click on your second variable. This will create a curved arrow which can be adjusted using the handle (as above).
- Continue curving the arrows as in the diagram below.
- Click on *access to care* and move it to the left of the arrow connecting *workload* and *utilization of primary care services* (see diagram below).

Your diagram should now look something like this:

![Diagram](image.png)

**Editing Variables**

- To edit a variable name, click on it with the **Variable** tool to open the editing box, then type in a new name.
Dealing with Variables

If you want to delete a variable from the model you can use either Edit>Cut, (Ctrl + X), or press the Del key on the keyboard (both of which open a prompt dialog). You can also use the Delete tool which deletes from the model with no prompt.

- Select the Variable tool and click on the sketch, then type in the name temporary and press Enter.
- Select the Delete tool and click on the variable temporary.

Undo and Redo

If you make a mistake while creating a model, you can use the menu item Edit>Undo (or Ctrl+Z) and Edit>Redo (Ctrl+Y) commands.

Saving Your Model

- Click the Save button or select the menu item File>Save or press Ctrl + S. For now, call this file project.

Models can be saved in text format, the default, with the file extension .mdl.

MODIFYING DIAGRAMS

Objects in your sketch have options which you can change and customize. Two different methods are used to change sketch options:

- Right click on a sketch object (on a Mac, Ctrl + Click)
- Click on a sketch object (variable, arrow, etc.) and use the Status Bar (at the bottom of the sketch) to change the options or attributes of the selected object.

Selecting Sketch Objects

Several methods allow you to select single or multiple sketch objects.

- Click on a single object with the Move/Size tool.
- Select multiple objects by holding the mouse button down and dragging the Move/Size (or Lock) tool over a region of sketch OR by holding down the Shift key and clicking on each object with the Move/Size tool.
- Select the whole sketch with Edit>Select all (or Ctrl + A).
- Deselect objects which are selected by holding down the Shift key and clicking on each object with the Move/Size tool.
GUIDANCE NOTE: HOW TO USE VENSIM

- Deselect all objects by clicking on a blank region of sketch (outside of the selection rectangle).

**SKETCH OPTIONS**

### Variables

- Select the **Lock** tool. Right click on the variable *utilization of primary care services*. For a Mac, hold the Control key down and click with the mouse button (Ctrl + Click).

An options dialog box will open.

- Change the font (e.g., to Arial), the size, color, or anything else, then click **OK**.
- Select menu **Edit>Select all** or press Ctrl + A. On the Status Bar at the bottom of the window click on the font size button (probably reads **12**) and choose a bigger size, say **14**. Click outside of the highlighted box.

### Arrows

- Right click on the arrowhead of the arrow from *user fees* to *utilization of primary care services*, an options dialog box will open:
As user fees increase, access to care decreases, a negative causality.

- Select - (under Polarity) and Outside (of the arrow’s curve) then click OK.

As access to care increases, utilization of primary care services increases, a positive causality.

- Select + (under Polarity) and Outside (of the arrow’s curve) then click OK.
- Continue changing the polarity of arrows according to the figure below, selecting Inside or Outside of the arrow’s curve as appropriate:
There is a feedback loop connecting utilization of primary care services, workload and quality of care. You can highlight this feedback loop and other elements of your diagram by using different sized and colored arrows.

- Select the Move/Size tool. Click on the arrowhead of the arrow from quality of care to utilization of primary care services. Now hold down the Shift key and click on the other arrowheads of arrows from:
  - utilization of primary care services to workload
  - workload to quality of care

This will highlight all the handles and show a dotted box around the perimeter of the selected arrows.

- Release the Shift key.
- On the Status Bar (at the bottom of the window), click on and choose the fifth line from the top. All highlighted arrows will increase in width.
- Click on the color button (probably colored blue) just to the left of and choose a different color (e.g., red). Now unselect the arrows by clicking somewhere on the diagram outside of the dotted box.

The effect of quality of care on utilization of primary services is likely characterized by some delay. That is, a sudden change in quality of care will not necessarily translate to a sudden change of utilization of primary care services. If, for example, the quality of care drastically improved, it may take some time before health care users in the community who previously did not use the services are interested in using the higher quality services. You can illustrate this delay in effect in your diagram.

- Right click on the arrowhead of the arrow from quality of care to utilization of primary care services. In the dialog box select Delay Mark.

Your diagram should now look something like this:
Adding Comments and Graphics

- To move your diagram, select the **Move/Size** tool and choose menu **Edit>Select all** (or Ctrl + A). Then drag the whole diagram lower to make room for a title.

- Select the **Sketch Comment** tool. Click at the top of your sketch and the Comment dialog box will open.

- Type in a title for your sketch (e.g., Utilization of Primary Care Services Model). Choose a font, size, color, shape and word position for your comment, then click **OK**.

- Still using the **Sketch Comment** tool, click on the sketch in the center of the feedback loop. Click on the dropdown arrow in the **Graphics** field **Image** box and choose the negative sign ( - ), then from the **Shape** field choose **Loop Clkwse** (clockwise).

- Click on the **Color** button (right under the font size) and click on red in the color palette that appears. Repeat this with the button labeled **Shape color**, and click **OK**. If you need to, reposition the loop image and resize the loop by dragging its handle.
Your diagram should now look similar to the figure below:

**PRINTING AND EXPORTING THE SKETCH**

The sketch can be printed by clicking the **Print** button or by selecting the menu item **File>Print**.
GUIDANCE NOTE: HOW TO USE VENSIM

The Print Options dialog gives a number of options, the more important ones are:

- **Selection** — print whole view, or print selected (portion of view), or print all views
- **Orientation** — portrait or landscape orientation
- **Size** — fit to page will fit your view onto a single page.
- **Title** — this will appear on the top of the printed page.

The sketch can be exported to the clipboard for use in other applications by using **Edit>Select all** (or selecting a group of variables with the **Lock** tool) then selecting **Edit>Copy** (Ctrl + C). This exports the sketch information to the clipboard as a metafile, which can then be pasted into other applications.

### STRUCTURAL ANALYSIS OF DIAGRAMS

#### ANALYSIS TOOLS

Vensim Analysis tools fall into two broad classes: tools for structural analysis, and tools for dataset analysis. Structural tools allow you to investigate the model structure; dataset tools allow you to investigate simulation datasets to determine the behavior of variables. In this section, we will analyze the structure of our model. Structural Analysis tools include the **Tree Diagram** tool (**Causes Tree** and **Uses Tree**), the **Loops** tool, and the **Document** tool.

Analysis tools almost always work by generating information about the Workbench Variable. You select the Workbench Variable by one of two methods. The easiest method is to click on the variable, wherever it appears. The variable is usually somewhere in one of the sketches, unless the model is text-based. You can also click on a variable in an Output window, such as a **Tree Diagram** or a **Strip Graph**. The second way to select a variable into the workbench is to click the **Control Panel** button to open the Control Panel, select the tab **Variable** to open the Variable Selection Control, then choose the variable from the list. The Workbench Variable always appears on the title bar of the model.

**NOTE** If you activate an Analysis tool that requires a simulation dataset, and you have no simulation dataset loaded, you will see the message "No runs are loaded. Please load runs". This tells you that you need to run a simulation. Chapter 5 will describe how to build a simulation model.

- In the model **primary care.mdl** that you just built, select the **Lock** tool. Now click on the variable **utilization of primary care services** to select it as the Workbench Variable.
Causal Tracing is a powerful tool for moving through a model tracing what causes something to change. Causal Tracing Analysis tools can be configured to show the causes of a variable or the uses of a variable (the opposite direction to causes).

**Causes Tree Diagram**

- Click on the **Causes Tree** tool (the AB>C button left of [ ] at the top of the page). We see the causes of **utilization of primary care services**:

We can trace through the diagram looking at what causes any particular variable.

- In the tree diagram window click on **quality of care** then click on the **Causes Tree** tool again:
We can see that quality of care is driven by staff motivation and by workload, which is in turn driven by utilization of primary care services. Now we have traced a feedback loop, starting and finishing at utilization of primary care services.
Loops Tool

We can also identify loops through the Loops tool.